Using Freeway
Copyright and acknowledgements

This guide is intended for Freeway 4 Pro, but covers areas common to Freeway 4 Express. Where a feature is Freeway 4 Pro only, it is marked in the text.

Copyright © 1997-2006 Softpress Systems Ltd. All rights reserved.

The Freeway software and this documentation are copyright materials. No part of the Freeway software may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language, or computer language, in any form or by any means without the prior written permission of Softpress Systems Ltd. Additional copies of this guide may be made and distributed provided they include this copyright notice.

Softpress Systems Ltd specifically retains title to all Freeway computer software. The software described in this guide is furnished under a licence agreement and may only be installed, used, or copied in accordance with the terms of that agreement.

Softpress is a trademark of Softpress Systems Ltd in the United States and other countries. Freeway is a trademark of Softpress Systems Ltd, which may be registered in some countries.

Apple, Macintosh, Power Macintosh, and the Mac Logo are registered trademarks of Apple Computer Inc. All other product names are trademarks, or registered trademarks of their respective owners.

Limitation of liability

The information in this guide is believed to be correct as of the date of publication. However, our policy is one of continuous development and so the information in this guide is subject to change without notice, and does not represent a commitment on the part of Softpress Systems Ltd.

Contact details

You can reach Softpress Systems using the following contact details:

Softpress Systems Ltd
First Floor
25 Hanborough House
Hanborough Business Park
Witney, Oxon, OX29 8LH
United Kingdom

Tel: (+44) 1993 882588
Fax: (+44) 1993 883970

Web: http://www.softpress.com/
Email: info@softpress.com

Assumptions and conventions

To avoid ambiguity this guide adopts the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Identifies a name or label that appears on the computer screen. For example: Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td><strong>Computer</strong></td>
<td>Identifies text that you key in at the computer keyboard.</td>
</tr>
<tr>
<td><code>ctl</code> <code>~</code> <code>⌘</code></td>
<td>Represent the special keys on the keyboard: Control, Option (or Alt), Command.</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>---</td>
</tr>
<tr>
<td>Setting up a site</td>
<td></td>
</tr>
<tr>
<td>Creating a new site</td>
<td>1</td>
</tr>
<tr>
<td>Saving files</td>
<td>2</td>
</tr>
<tr>
<td>Restoring backups</td>
<td>3</td>
</tr>
<tr>
<td>Publishing and previewing</td>
<td></td>
</tr>
<tr>
<td>Publishing your site</td>
<td>5</td>
</tr>
<tr>
<td>Previewing your site</td>
<td>6</td>
</tr>
<tr>
<td>Uploading your site to a Web server</td>
<td>7</td>
</tr>
<tr>
<td>Publishing your site on your own computer using personal Web sharing</td>
<td>8</td>
</tr>
<tr>
<td>Designing your site</td>
<td>11</td>
</tr>
<tr>
<td>Changing the view</td>
<td>12</td>
</tr>
<tr>
<td>Producing accurate layouts</td>
<td>13</td>
</tr>
<tr>
<td>Aligning items</td>
<td>17</td>
</tr>
<tr>
<td>Working with color</td>
<td>17</td>
</tr>
<tr>
<td>Working with pages</td>
<td>21</td>
</tr>
<tr>
<td>Creating pages</td>
<td>22</td>
</tr>
<tr>
<td>Achieving consistent design with master pages</td>
<td>23</td>
</tr>
<tr>
<td>Creating master pages</td>
<td>24</td>
</tr>
<tr>
<td>Applying master pages</td>
<td>25</td>
</tr>
<tr>
<td>Structuring your site</td>
<td>26</td>
</tr>
<tr>
<td>Linking to a page</td>
<td>28</td>
</tr>
<tr>
<td>Linking within a page</td>
<td>29</td>
</tr>
<tr>
<td>Linking to other sites</td>
<td>31</td>
</tr>
<tr>
<td>Managing links in the link map</td>
<td>32</td>
</tr>
<tr>
<td>Defining the appearance of links</td>
<td>32</td>
</tr>
<tr>
<td>Defining image maps</td>
<td>33</td>
</tr>
<tr>
<td>Working with text</td>
<td>35</td>
</tr>
<tr>
<td>Options for including text on a Web site</td>
<td>36</td>
</tr>
<tr>
<td>Creating text items</td>
<td>37</td>
</tr>
<tr>
<td>Specifying the appearance of text</td>
<td>39</td>
</tr>
<tr>
<td>Editing text</td>
<td>41</td>
</tr>
<tr>
<td>Checking your spelling</td>
<td>42</td>
</tr>
<tr>
<td>Applying effects to graphic text</td>
<td>43</td>
</tr>
<tr>
<td>Working with styles</td>
<td>46</td>
</tr>
<tr>
<td>Working with style sheets</td>
<td>50</td>
</tr>
<tr>
<td>Working with graphics</td>
<td>53</td>
</tr>
<tr>
<td>Using graphics on your Web pages</td>
<td>54</td>
</tr>
<tr>
<td>Creating graphics</td>
<td>55</td>
</tr>
<tr>
<td>Manipulating graphic items</td>
<td>57</td>
</tr>
<tr>
<td>Resizing graphics</td>
<td>59</td>
</tr>
<tr>
<td>Adding effects to graphics</td>
<td>60</td>
</tr>
<tr>
<td>Combining graphics</td>
<td>63</td>
</tr>
<tr>
<td>Controlling how graphics are exported</td>
<td>64</td>
</tr>
<tr>
<td>Using multimedia</td>
<td>65</td>
</tr>
<tr>
<td>Managing resources</td>
<td>67</td>
</tr>
<tr>
<td>Publish problems</td>
<td>68</td>
</tr>
<tr>
<td>Working with tables</td>
<td>69</td>
</tr>
<tr>
<td>Creating tables</td>
<td>70</td>
</tr>
<tr>
<td>Moving and resizing tables</td>
<td>71</td>
</tr>
<tr>
<td>Selecting cells</td>
<td>72</td>
</tr>
<tr>
<td>Resizing rows or columns</td>
<td>73</td>
</tr>
<tr>
<td>Editing tables</td>
<td>74</td>
</tr>
</tbody>
</table>
Joining and splitting cells 74
Specifying the appearance of tables 75

Working with forms 77
What are forms for? 78
Creating a form 78
Button 79
Checkbox 80
Radio button 80
Menu/List 80
Text field 82
Text area 82
Setting up your form 83

Creating dynamic effects 85
What actions do 86
Summary of actions 86
Dynamic buttons and text 90
Slave images and layers 93
Animation 94
Pop-up windows 96
Navigation 99
Graphics actions 100

Index 101
About the Freeway documentation

**Getting Started with Freeway**

The *Getting Started with Freeway* guide is the ideal place to start learning about how to get the most out of Freeway. It includes an overview of Freeway’s unique features and benefits, information about planning your site and publishing it on the Web, a guided tour of Freeway’s main features, and a series of three tutorials showing how to use Freeway to create stunning Web sites.

**Using Freeway**

This *Using Freeway* guide provides clear step-by-step instructions for using all the main features of Freeway, including setting up, previewing, and publishing a site, working with pages, text, graphics, tables, and forms, and creating dynamic effects. It is designed to help you translate your vision into a complete, fully working Web site.

**Freeway Reference**

The *Freeway Reference* guide is aimed at more advanced Freeway users, and provides detailed reference information about advanced Web design features that may not be needed by all users. It also provides information about migrating from existing sites created in other Web programs, and a summary of the Freeway preference panels, palettes, and keyboard shortcuts.

**On-line Help**

Freeway also includes a comprehensive integrated context-linked on-line help system which you can use to find information about features while you are using the product. This includes the same information as provided in the *Using Freeway* and *Freeway Reference* guides.

**The KnowledgeBase**

The Softpress Web site also provides an advanced KnowledgeBase containing a wide range of information on every aspect of using Freeway, including technical notes on specific features, tutorials illustrating how to achieve particular effects, answers to frequently asked questions, and examples of sites created by third-party designers using Freeway. The knowledge base is fully searchable and is being extended on a weekly basis to provide answers to any question that users ask about Freeway.
This chapter explains how to create a new site, either from a template, or by specifying custom settings. It also explains how to add pages, view the site files in the Site panel, and see the structure of the site in the Link Map (Freeway 4 Pro Only).
Creating a new site

Freeway stores all the information about your Web site in a single site document.

To create a new site document

• Open the File menu and choose New….

The New Document dialog box is displayed to allow you to specify settings that will apply to your entire site.

Either:

• Click the Templates tab to display sets of predefined templates to help you create a site in a specific style:

Or:

• Click the Custom tab to specify the settings explicitly for a new blank site Freeway 4 Pro Only:

The following table explains the meaning of each of the options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default HTML</td>
<td>Specifies the default output setting for pages in the site. You can override this for individual pages at a later stage.</td>
</tr>
<tr>
<td>Default page size</td>
<td>Specifies the default size, in pixels, for new pages in the site. Either choose one of the predefined page sizes from the pop-up menu, or specify the Width and Height in the corresponding fields.</td>
</tr>
<tr>
<td>Site folder</td>
<td>Allows you to specify the location of the site folder, which will contain the site files when you publish the site.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Resources</td>
<td>Allows you to specify where the graphics and other resource files are stored when the site is published: <strong>Common Resource Folder</strong> stores all the images in a single folder, <strong>Separate Resource Folders</strong> stores the images in a separate folder for each site subfolder, and <strong>With HTML Files</strong> stores the images loose with the HTML files.</td>
</tr>
<tr>
<td>File names</td>
<td>Specifies the format for the file names generated by Freeway when the site is published, to ensure compatibility with the Web server you are going to use for hosting your site. Choose <strong>Alphanumeric</strong> for maximum compatibility with old Web servers, <strong>DOS</strong> for MS-DOS Web servers, or <strong>UNIX/Windows</strong> for current Web servers including Mac OS X, Windows, and Linux.</td>
</tr>
</tbody>
</table>

- Click the **OK** button to create the new site.

If you selected a template you are prompted to save the site. Freeway creates a **Site Folder** to contain the HTML files and resources generated when you publish the site, and a **Media** folder to contain your master images and other materials:

![Site Folder](image)

### Saving files

#### To save the site
- Open the **File** menu and choose **Save**.

The first time you save a custom site the **Save** dialog box will be displayed to allow you to specify a name for the site and the location:

![Save Dialog](image)

If you want to save the document as a template:
- Select the **Template** button.
- Click the **Save** button to save the document.

### Restoring backups

Freeway automatically makes a copy of your document when you do your first save after opening it. The backup copy has the same name as the original, with the suffix `.fwbackup`. If for some reason you have a problem opening a document file, such as due to a disk fault, you should still be able to open the backup file and recover all but your latest work.

#### To restore a backup file
- Double-click the backup file icon.

It will be opened as a new untitled document.
This chapter explains the options for previewing your site, either in Freeway or in an external Web browser of your choice. It also explains how to publish your site, and upload it to your external Web space.
Publishing your site

Publishing your site generates the HTML pages with their associated graphics and other resources.

**To publish your site**
- Open the **File** menu and choose **Publish Site**.

Note that publishing your site automatically replaces any obsolete HTML or graphic files in your site folder, so you should not normally edit these files manually.

Previewing your site

Previewing your site automatically publishes the site, and then loads the current page into a specified Web browser. This allows you to see how your content will appear in the Web browser and check your links and other active features.

**To preview your site in Freeway**
- Click the **Preview** button at the bottom right of the Freeway window:

The current page will be previewed.

**To preview your site in a Web browser**
- Open the **File** menu and choose **Preview in Browser**, then choose the Web browser you want to use on the submenu:

Initially the submenu shows **Safari**, the browser supplied with Mac OS X, but you can add other browsers to the submenu using the **Browser Setup…** option as described below.

**To add a browser to the Preview submenu**
- Open the **File** menu and choose **Preview in Browser**, then choose **Browser Setup…** from the submenu.
The following dialog box shows a list of the browsers you have currently selected for previewing, and it allows you to add new browsers or delete browsers:

To add a new browser to the menu
- Click the New… button, then locate the browser on your computer and click the Open button to add it to the list.

To remove a browser from the menu
- Select the browser and click the Delete button.

To search for all the browsers on your hard disks
- Click the Update button.

To specify the default browser
The default browser is indicated by a checkmark in the Default column.
- Click in the Default column to check the browser you want to use as the default.

Uploading your site to a Web server
To make your Web site available on the Internet you need to copy the HTML and resource files to a suitable Web server, and this is called uploading the site.

The procedure depends on whether you have a Web server that you access via FTP, a .Mac account, or a Web server that you access simply using file copy.

To upload via FTP
If your Web space is provided by an Internet Service Provider, the most usual way of uploading your files to your Web space is via FTP. To do this you need to know the server name, directory to contain the files, and your log-on user name and password.
- Open the File menu and choose Upload…, then choose FTP from the Upload pop-up menu:
  - Enter the FTP details in the appropriate fields.
    - The Directory is optional and can be left blank.
    - Alternatively leave the User name and Password blank, and Freeway will prompt you to enter them each time you upload to the site.
• Select **Passive FTP Mode (PASV)** if your ISP requires it, or if upload fails without it.
• Leave **Save FTP log** unchecked unless your ISP has specifically requested that you select it.

Occasionally an ISP may require you to enter certain FTP commands to access the site, and you can enter these by clicking the **Script…** button.

• Click the **OK** button to upload the files via FTP.

**To upload your site to a .Mac account**

- Open the **File** menu and choose **Upload…**, then choose **.Mac** from the **Upload** pop-up menu:

  ![Upload .Mac](image)

  - Enter your member name and password in the appropriate fields and click the **OK** button to upload the site.

Your site can then be accessed via the address:

http://homepage.mac.com/mynname/

where **mynname** is your .Mac member name.

Note that .Mac assumes that the default page of your site is called **index.html**, so you should make sure that your home page has this file name.

---

**Publishing your site on your own computer using personal Web sharing**

You can use the personal Web sharing built into Mac OS X to host your Web site from your own computer. In this case you upload your site using file copy.

**To turn on personal Web sharing**

- Open the **Sharing** panel in the **System Preferences** dialog box on your computer.
- In the **Services** section select **Personal Web Sharing**:
To upload files using file copy

- Open the File menu and choose Upload…, then choose File Copy from the Upload pop-up menu:

- Click the Select… button and browse to the location where you want to upload the site.

If you are using personal Web sharing this will be the Sites folder in your home folder.

You can then access your site using the address:

http://xxx.xxx.xxx.xxx/myname/

where xxx.xxx.xxx.xxx is the IP address of your computer, and myname is your user name.
This chapter explains the general design features for working in Freeway, including options for changing the view, using rulers, guides, and grids, aligning items, and the color options.
Changing the view

When you are working on a site page or master page you can choose what scale you work at, and when viewing an enlarged version of your page you can pan the page. You can also work with several views on the same page.

To change the scale

- Choose the scale from the pop-up Zoom menu at the bottom right of the Freeway window:

  ![Zoom menu](image)

To specify a precise magnification

- Choose Other… from the Zoom menu.

The following dialog box allows you to specify a scale between 5% and 1600%:

  ![Zoom dialog box](image)

- Enter the scale and click the OK button to zoom to the specified scale.

To fit the whole page within the Freeway window

- Open the View menu and choose Fit in Window, or choose Fit Page in Window from the Zoom menu.

To pan the page area

- Hold down Alt.

The mouse pointer changes to a grabber hand.

- Drag in the page area with the mouse pointer.

To work with multiple views [Freeway 4 Pro Only]

- Open the Window menu and choose New Window to open a new window on the same site.

For example, you can work on a close-up of one part of your page while seeing an overview of the whole page in a separate window:
Producing accurate layouts

Freeway provides several features to help you produce consistent layouts and align items accurately:

- Rulers along the top and left-hand edges of the page area.
- Ruler guides which you can add to the page to align items accurately.
- Vertical and horizontal grids with a specified interval
- Margin guides, to create a consistent top and left inset for the page

The guides and grids help you align objects horizontally or vertically, and you can optionally snap objects to the nearest guide or grid. Guides and grids do not appear on the page when it is published.

To show or hide the rulers

- Open the View menu and choose Show Rulers or Hide Rulers.

Rulers are displayed by default when you open a new document.

The rulers are calibrated in pixels, and by default the origin is at the top left corner of the page.

To change the ruler origin

- Drag from the px symbol at the top left corner where the rulers intersect.

Crosswires follow the mouse pointer.

To reset the ruler origin to the top left corner of the page

- Double-click the px indicator where the rulers intersect.

To add guides to the page

- Make sure the rulers are visible; if necessary open the View menu and choose Show Rulers.
- Make sure Guides is checked in the View menu; if necessary open the View menu and choose Guides.
- Position the mouse pointer over the vertical or horizontal ruler until it changes to a drag symbol.
Designing your site

To snap to guides or the grid

- Open the View menu and choose Snap to Guides.

When you move the edge of an item near to a guide or grid line it will snap to the precise position.

To display guides in front of objects on the page

- Open the View menu and choose Guides Above.

By default guides are displayed behind graphics and other objects on the page.

To lock the guides

- Open the View menu and choose Lock Guides.

This prevents you from accidentally moving the guides once you have set them up in the correct positions.

To remove a guide

- Drag it and drop it outside the page area.

To display a grid Freeway 4 Pro Only

- Open the Page menu and choose Grids....

The Grids dialog box allows you to define a vertical and horizontal grid and apply it either to the current page, or to every page in the document:

- Select Vertical and/or Horizontal to draw a vertical and/or horizontal grid.
- In the Width and Height fields specify the spacing between gridlines.
- If you want to add space between pairs of grid lines specify the space in the Gutter fields.
- If you want to inset the grid from the top left corner of the page, specify the inset in the Left and Top fields.

The Right and Bottom fields will automatically be set to the inset of the grid from the bottom right corner of the page.
• Choose **Page** from the **Apply to** menu to apply the grid to the current page, or **Document** to apply it to every page in the site.
• Click the **Apply** button to preview the grid:

![Grid Preview](image)

• Click the **OK** button to use the grid you have defined.

**To align items to the grid  Freeway 4 Pro Only**

• Select one or more items on a page.
• Open the **Item** menu and choose **Align to Grid**.

Each item will be moved so that its top and left borders are on the nearest gridline.

**To define margins  Freeway 4 Pro Only**

• Open the **Page** menu and choose **Grids**.

![Margins Configuration](image)

• In the **Margins** sections set the **Top**, **Left**, **Bottom**, and **Right** fields to the margins you want to define:

![Margins Preview](image)

• Choose **Page** from the **Apply to** menu to apply the margins to the current page or **Document** to apply them to all pages in the site.
• Click the **Apply** button to preview the margins:

![Margins Preview](image)

• Click the **OK** button to use the margins you have defined.
To define the color for the guides

- Open the Freeway menu and choose Preferences....
- Click the Grids & Guides icon at the top of the Preferences dialog box to display the Grids & Guides options:

  ![Grids & Guides dialog box]

  - Click the Grid color, Horizontal guide color, Vertical guide color, and Margin guide color boxes to define the colors of the corresponding guides.
  - Click the Link checkbox to keep the horizontal and vertical guides the same color.

To define the snap-to distance for the grid and guides **Freeway 4 Pro Only**

- Open the Freeway menu and choose Preferences....
- Click the Grids & Guides icon at the top of the Preferences dialog box to display the grids and guides options:

  ![Grids & Guides options]

  - Edit the Grid magnetic range and Guide magnetic range to the values you want to use:

    - A recommended value is 5 pixels.
Aligning items

You can align two or more items horizontally and/or vertically to achieve a consistent layout on the page.

To align items

- Select two or more items on the page.
- Open the Item menu and choose Align…

The Alignment dialog box allows you to specify how you want to align the items horizontally and/or vertically:

- In the Horizontal section click the appropriate icon for no horizontal alignment, left alignment, center alignment, or right alignment.
- In the Vertical section click the appropriate icon for no vertical alignment, top alignment, center alignment, or bottom alignment.
- Click the OK button to align the items.

Working with color

Freeway handles the colors of text, graphics, and other objects in your site in a consistent way using the Styles and Colors palette.

Freeway maintains a list of all the colors used in your document, and you can give these convenient names, or define your own permanent library of colors, to ensure consistency across your Web pages.

To apply a document color

- Open the Window menu and choose Styles and Colors to display the Styles and Colors palette.
- Click the color icon at the top of the Styles and Colors palette to display the document colors:

- Select the feature you want to apply the color to from the Apply to pop-up menu.
The available options will depend on what you have selected, as shown in the following table:

<table>
<thead>
<tr>
<th>Selected</th>
<th>What you can change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nothing</td>
<td>Page background color.</td>
</tr>
<tr>
<td>HTML item</td>
<td>Background or border color.</td>
</tr>
<tr>
<td>Table</td>
<td>Background or border color.</td>
</tr>
<tr>
<td>Graphic item</td>
<td>Shadow, glow, background, foreground, or border color.</td>
</tr>
<tr>
<td>Text in an HTML item</td>
<td>Text or text background color.</td>
</tr>
<tr>
<td>Text in a graphic item</td>
<td>Text, text background, text shadow, text glow, or text outline color.</td>
</tr>
</tbody>
</table>

- Click the color you want to apply.

**To apply a Web-safe color to an object**  
*Freeway 4 Pro Only*

This is a set of 216 colors recommended for use on the Web, as they are supported in a consistent way on most computers.

- Select the feature you want to apply the color to from the Apply to pop-up menu.

The options will depend on what you have selected.

- Click the color you want to apply.

The new color will be added to the end of the document colors list, with a name such as **Color 1**:
To apply an arbitrary color to an object

**Freeway 4 Pro Only**

- Click the color options icon at the top right of the Styles and Colors palette, and choose **Color Picker**... from the pop-up menu:

The **Color Picker** provides five alternative ways of choosing colors.

To add a color to the document colors list

- Click the color options icon at the top right of the Styles and Colors palette, and choose **New Color**... from the pop-up menu.

The **Color** dialog box allows you to define the new color and give it a name:

- Select a color from the Web-safe colors palette, or click the Color picker icon in the bottom left corner of **Color** dialog box and use the **Color Picker** to define an arbitrary color.
- Click the **OK** button to add the color you have defined to the document colors list:
To edit the document colors  

- Click the color options icon at the top right of the Styles and Colors palette and choose Edit Colors… from the pop-up menu.

The Edit Colors dialog box shows a list of all the colors in your document and allows you to add new colors, import colors from another document, or edit the colors:

![Edit Colors dialog box](image)

Built-in colors are identified by a padlock icon in the left column; you cannot edit or delete these.

Colors shown in bold are permanent. They will remain in the document colors list even if they are not used in the site.

To create a new color  

- Click the New… button and follow the method described above for adding a new color.

To import the permanent colors from another document  

- Click the Import… button, locate the other site document, then click the Open… button to import its permanent colors into the document colors list.

To edit a user-defined color  

- Select it in the Edit Colors dialog box and click the Edit… button.

To delete a user-defined color  

- Select it in the Edit Colors list, and click the Delete button.

If the color is in use in your site you will be prompted to select a color to replace it.
This chapter describes the options for working with pages in Freeway, including the procedures for creating pages, creating and using master pages, linking between pages and within a page, and managing links using the Link Map.
Creating pages

Each page in your Web site corresponds to a separate page in your Freeway document.

Site pages

In a Freeway document, pages in the site are represented on the screen by a black outline with a drop shadow showing the edge of the page. The area outside the page is called the pasteboard. You can use this area for working, but only items inside the page border will be published to your Web pages.

Master pages

Each page in your Freeway document is associated with a master page. Items on a master page appear on each page it’s based on.

To create new pages

• Open the Page menu and choose New Pages....
• Enter a title for the page(s) in the New Pages dialog box:
  • Enter the number of pages you want to create.
  • Select the master page you want to use from the Master pop-up menu.
  • Click the OK button.

To specify the title and file name

• Click the page icon at the top of the Inspector palette to display the general page settings:
  • Enter the page title and file name in the Title and File fields.

The home page should normally be named index.html unless you are advised otherwise by your ISP. This will be displayed by default when a user connects to your site.

To apply a background color to a page

• Click the paintbrush icon at the top of the Inspector palette to display the page’s appearance settings.
• If necessary, click the  to expand the Background section of the Page panel.
• Choose the color from the Color pop-up menu:

By default, Freeway creates pages that will display in the browser with a white background.
To apply a background image to a page

You can select any GIF, JPEG, or PNG image to be used as the background to a page.

Either:

- Drag an image from the Finder or another application and drop it onto an empty area of the page, while holding down Shift.

Or:

- Click the paintbrush icon at the top of the Inspector palette to display the page’s appearance settings.
- If necessary, click the ▼ to expand the Background section of the Page panel.
- Choose Select… from the Image pop-up menu:

  ![Select Image](image)

  - Select a suitable image and click the Open button.

By default the image will be tiled horizontally and vertically to fill the entire browser window but you can choose alternative options using the Horizontal and Vertical pop-up menus.

Achieving consistent design with master pages

Master pages make it easy to create a series of pages in your site with a consistent design. Any items you define on the master page will automatically appear on any pages that use that master page.

For example, you might create a master page to define a standard header:
Any pages based on this master page will automatically include the header:

To view the master page for the current page

- Click the Master tab in the bottom right corner of the Freeway window:

Creating master pages

You can either create a new blank master page, or you can create a master page from an existing page.

**To create a new blank master page**

- Open the Page menu and choose New Master....

The following dialog box allows you to specify the new master page:

- Enter a title for the master page.
- Click the OK button.
To create a master page from the current page

After designing a page you may realize you want to reuse the same design on a series of related pages. The easiest way to do this is to create a master page from the page.

- Select the page you want to use.
- Open the Page menu and choose Make Master....

The following dialog box allows you to give the master page a title:

- Enter a title for the master page.
- Click the OK button.

A new master page will be created containing the items on the current page.

Applying master pages

To apply a different master page to the current page

- Click the page icon at the top of the Inspector palette to display the general page settings.

- Choose the master page you want to apply from the Master pop-up menu:

To reapply the items from the master page

- Open the Page menu and choose Reapply Master.

Any master items you subsequently modified on the page will remain, and copies of the original unmodified items will be copied from the master page. You may need to delete the duplicate items you do not require.
Structuring your site

The Site panel, to the left of the main Freeway window, provides an overview of the structure of your site. It provides a convenient way of creating pages, master pages, and folders, and allows you to change the current page, move pages between folders, or delete pages.

The top section of the Site panel shows the master pages in your document. The lower section shows the structure of folders and pages in your Site Folder, with the current page shown highlighted:

To change the current page

- Click the page icon in the Site panel:

To create new pages from the Site panel

- Click the site options icon below the Site panel and choose New Pages... from the pop-up menu:

  The New Pages dialog box is displayed:

  - Enter the Title and number of pages and click the OK button to create the pages.

To create a new folder from the Site panel

If your site contains a large number of pages you can divide up the site using folders and subfolders to keep related pages together.

When you publish the site, the folder structure will be reflected in the structure of the HTML pages generated by Freeway.
• Open the site options pop-up menu and choose New Folder.

The following dialog box lets you give the new folder a name:

• Enter a name and click the OK button.

It will be added to the bottom of the Site panel:

To rename a page, master page, or folder from the Site panel
• Hold down ⌘ and click the item.
• Type in the new name:

To delete a page, master page, or folder from the Site panel
• Select the item in the Site panel.

You can select multiple pages or master pages by holding down Shift or ⌘ as you click:

• Click the – button below the Site panel, or press Delete.
To rearrange pages
You can use the Site panel to rearrange the order of the pages in your document. Note that this has no effect on how the site is viewed by the visitor.

- Drag the page up or down to a new position in the Site panel.

To move a page into a folder
- Drag it below the folder icon in the Site panel:

The page will be indented to show it is contained in the folder:

To create a master page from a page
- In the Site panel drag the page icon and drop it in the master section at the top of the palette.

You will be prompted to give the master page a title:

- Click the OK button to create the master page.

Linking to a page
Links, also called hyperlinks, are items on the page, typically sections of text or graphics, which act as buttons so that when the user clicks on them a different page is loaded into the browser. They allow visitors to navigate between pages on your site, within a page, or to other locations on the Internet.

To define a graphic as a hyperlink
- Select the graphic item.
- Drag the page you want to link to from the Site panel to the Hyperlink field at the bottom of the Freeway window:
The graphic will be shown with a link icon, and the name of the page it links to will be shown in the Hyperlink field:

If you create a hyperlink from text in an HTML item the text will be displayed in the link style, by default underlined in blue.

For more information about how you can contribute to our conservation program click here.

If you create a hyperlink from text in a graphic item Freeway will automatically create an image map positioned over the text.

You can also define links using the Edit Hyperlink dialog box:

- Open the Edit menu and choose Hyperlink…, or click the button to the left of the Hyperlink field and choose Other… from the pop-up menu.

For more information about the alternative options see the following sections.

**To define a selection of text as a hyperlink**

- Select the text in an HTML item or graphic item that you want to turn into a hyperlink.
- Drag the page you want to link to from the Site panel to the Hyperlink field at the bottom of the Freeway window.

**Linking within a page**

In addition to being able to link to a different page, you can also link to a specified location, called an anchor, attached to an item on a page. When the user clicks the link, the page is automatically scrolled to the position of the item within the browser.

This is useful if you have a long document on a single page, such as a list of products organized into categories, and you want to allow the user to jump straight to the appropriate category heading in the list.

**To create an anchor**

- Highlight the text or insert the insertion point cursor where you want to create the anchor.
- Open the Edit menu and choose Anchor….
In the Define Anchor dialog box enter a name for the anchor and click the OK button:

An anchor symbol will be displayed to the left of the text or insertion point:

To create a hyperlink to an anchor

- Open the Edit menu and choose Hyperlink…, or click the button to the left of the Hyperlink field and choose Other… from the pop-up menu.
- In the Edit Hyperlink dialog box select Internal, click the page you want to link to, and select the anchor name from the Anchor pop-up menu:

To specify the target for a hyperlink

Normally when the user clicks on a hyperlink the new page is displayed in the same window as the previous page.

You can also specify that the new page should open in a separate window. This is useful if you want the user to be able to get back to the previous page easily, such as after displaying a help page.

- Open the Edit menu and choose Hyperlink….
- Choose _blank from the Target pop-up menu:

To follow a graphic hyperlink

- Select the graphic item containing the hyperlink.
- Open the Edit menu and choose Follow Link….
To follow an internal text hyperlink

- Select the text in an HTML item or graphic item that has been defined as a hyperlink, or position the insertion point somewhere within the hyperlinked text.
- Open the Edit menu and choose Follow Link.…

The current page in the Freeway document will change to the page linked to by the hyperlink.

Linking to other sites

To link to an external address

- In the Edit Hyperlink dialog box click the External tab and type the full external address into the URL box:

If you prefer, you can choose the URL prefix by selecting it from the Protocol pop-up menu.

To display a list of the external addresses in your document

- Open the Edit menu and choose URLs.…

The Edit URLs dialog box shows a list of the URLs and allows you to edit, check, or delete them:
Managing links in the link map

**Freeway 4 Pro Only**

**To display the link map**
- Click the Link Map tab at the bottom right of the Freeway window.

This shows both the internal and external links into the current page on the left and out from the current page on the right:

![Link Map](image)

**To extend the tree in any direction**
- Click the disc icon at the end of a path.

**To change the current page on the link map**
- Click the appropriate page icon.

**To go to the current page**
- Double-click its icon on the link map.

Defining the appearance of links

By default, text hyperlinks are displayed underlined in blue, active links are displayed underlined in red, and visited links are displayed underlined in purple.

Alternatively, for each page in your site you can override the defaults and specify how each style of link is displayed.

**To define the link colors**
- Click the paintbrush icon at the top of the Inspector palette to display the page’s appearance settings.
- Click the ▶ to the left of the Links heading to show the link options.
- Choose the color you want for each type of link from the Normal, Active, and Visited pop-up menus:

![Link Colors](image)

The color of the links will change to reflect the Normal color you have specified.

**To define the link styles**

In addition, if your output option is HTML 4.01 or XHTML you can define CSS link styles.

For example, if you want to change the link to red italic when the mouse pointer is over it:
- Design the style you want to use; see Working with styles, page 46.
Defining image maps

When you define a hyperlink for a graphic item, clicking anywhere on the graphic will link to the specified page.

Alternatively you can define an image map, which allows you to draw invisible buttons over different parts of the image, and define a separate hyperlink for each button. This is useful if you want to create a panel of buttons as a single graphic, or allow users to click on different areas of a single image, such as a map of the world.

To create an image map

- Draw a graphic item and import an image into it, or drag an image onto the page to create a graphic item automatically.
- Click on the Map Area button in the toolbar to display a pop-up menu of the map area tools.
- Use the tools to define each of the areas on the graphic that you want to make into a hyperlink.
The following table explains how to use each of the **Map Area** tools:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Map Area" /></td>
<td>Map Area</td>
<td>Drag to draw a square or rectangular map area.</td>
</tr>
<tr>
<td><img src="image2" alt="Oval Map Area" /></td>
<td>Oval Map Area</td>
<td>Drag to draw a circular or oval map area.</td>
</tr>
<tr>
<td><img src="image3" alt="Path Map Area" /></td>
<td>Path Map Area</td>
<td>Click at each of the vertices to draw a polygonal map area. Click and drag to draw a smooth Bezier curve. Click again on the last point to complete the polygon or curve.</td>
</tr>
</tbody>
</table>

Once you have drawn a map area you can edit it by clicking anywhere on the outline to select it, and then dragging any of the points on the outline.

You can also use the rotate tool, skew tool, or mirror (reflect) tool to transform a map area.
This chapter describes the options for incorporating text into your Web pages using either HTML text or graphic text. It explains the differences between the two options, and describes how style sheets enable you to create named styles to give consistency across your site.
Options for including text on a Web site

There are two options for including text on your Web site: HTML text or graphic text.

**HTML text**

HTML text is the most efficient way of representing text on a Web page, and is recommended for the body text. The text is represented as a string of characters, with formatting information, and the text is formatted and displayed in the browser.

If you don’t include any explicit formatting information with HTML text, the browser uses a default font and size to display it. Alternatively you can give a list of preferred fonts for displaying the text, called a Font Set, in which case the browser will choose the first available font to display the text. There is small set of standard fonts that are installed with most Web browsers, and you should choose one of these for predictable results.

Freeway also allows you to format HTML text using styles defined in a Cascading Style Sheet (CSS). This allows you to control a wide range of attributes of the text including the style, size, color, baseline shift, background color, letter spacing, and word spacing.

**Graphic text**

Graphic text represents the text as a graphic image on your Web site, and is recommended for headings, logos, and other key features of your site where you want precise control over the design and appearance.

With graphic text you can choose any font, style, or size, and because the text is sent as a complete graphic to the user’s browser, it will display correctly whatever fonts they have installed. You can also apply graphic effects to graphic text, including a drop shadow, embossing, outer glow, and shape effects.

Representing text as a graphic is less efficient than HTML text, so it takes longer to display. Another disadvantage is that graphic text does not get indexed by search engines, so users will not be able to search for phrases represented as graphic text on your site.
Creating text items

To create an HTML item

- Click the HTML icon in the toolbar:

![HTML](image)

- Drag to draw a rectangle to hold the text.

The HTML item will be selected to allow you to move it or resize it:

![HTML item selected](image)

HTML items are identified by a blue border, or a green border if defined as a CSS layer item.

To create a graphic item

- Click the Graphic icon in the toolbar:

![Graphic](image)

- Drag to draw a rectangle defining the graphic item:

![Graphic item](image)

Graphic items are identified by a gray border.

To type text into an HTML or graphic item

- Double-click the item to position the insertion cursor in the top left corner.
- Type the text you want to insert:

![Text](image)

If you create text in a graphic item the ascenders and descenders can extend beyond the boundary of the graphic item:

![Text extending](image)

In this case Freeway automatically creates a graphic box large enough to include the ascenders and descenders.

You can also type text into oval or bezier curved graphic items; for more information see Creating graphics, page 55.
Working with text

To insert text from a file

- Position the insertion cursor in the item where you want to import the text.
- Open the File menu and choose Import Text…:
  
  ![Import Text dialog box]

  - Select the text file you want to import and click the Open button to insert it.

To move an HTML or graphic item

- Position the mouse pointer within the item.
- Drag the item to the new position with the Select tool.

To copy an HTML or graphic item

- Position the mouse pointer within the item.
- Drag the item to the new position with the Select tool and press Option before releasing the mouse button.

To resize an HTML or graphic item

- Click the item with the selection tool to display the resize handles on its border.
- Drag one of the resize handles to resize the item:
  
  ![Resize handles]

  - Hold down Shift to constrain the size to a square, or Shift + Option to keep the proportions constant.

To transform a graphic item

- Click one of the transform tools (Important: only Rotate is available in Freeway 4 Express):
  
  ![Transform tools]

  - Click the item to display the resize handles on its border.
  - Drag one of the resize handles to transform the item:
    
    ![Transformed graphic]

    - When you release the mouse button the text will be redrawn transformed:

You cannot transform an HTML item.
Specifying the appearance of text

You can specify the appearance of text by selecting it and then using the options on the Inspector palette. The options available are divided into Character settings and Paragraph settings, and depend on whether it is HTML text or graphic text, and which version of HTML you are generating.

The options in the Character section apply to the currently selected characters, and you can apply different character formatting to different characters within a line or paragraph.

The options in the Paragraph section apply to the entire paragraph.

**HTML text, HTML 3.2**  
Freeway 4 Pro Only
The fonts are restricted to the standard Web fonts, or predefined font sets. Sizes are relative to the default size:

**HTML text, HTML 4.01**  
With HTML 4.01 (or the XHTML options Freeway 4 Pro Only) Freeway takes advantage of CSS style sheets to provide additional options, including absolute sizes, and indented paragraphs:

**Graphic text**  
With graphic text you can use any of the fonts available on your computer, at any size:
You can also apply a wide range of text effects, using the options on the text appearance settings panel of the Inspector palette:

To change the appearance of text
- Select the text you want to change.
- Select the options as required from the character and paragraph panel of the Inspector palette.

To select all the text in an HTML item or graphic item
- Double-click in the item to insert the insertion point in the text, and then open the Edit menu and choose Select All.

To create graphic text within an HTML item
If you need text in a distinctive font or style within a block of HTML text, you can convert it into graphic text. When you publish the site Freeway will convert the section of text into an in-line GIF image.
- Select the text you want to create as a graphic:

I really ♥ Freeway

To convert a paragraph into graphic text
You can also convert a complete paragraph into graphic text.
- Position the insertion point in the paragraph, and Select All.
- Click the text icon at the top of the Inspector palette.
- In the Paragraph section choose GIF from the Type pop-up menu to convert the selected characters into graphic text.

The formatting options will then change to the options for graphic text, and you can specify the settings as required:

I really ♥ Freeway
The formatting options will then change to the options for graphic text, and you can specify the settings as required.

**Editing text**

You can use the standard editing techniques to edit text within an HTML item or graphic item, including **Cut**, **Copy**, and **Paste**, selecting, and moving the insertion point using the cursor keys.

In addition Freeway provides find and replace, spelling check, and automatic hyphenation options.

**To find text**

- Open the **Edit** menu and choose **Find/Replace**, then choose **Find…** on the submenu.

The **Find** dialog box allows you to specify what you want to look for, and where you want to look:

- Set the **Range** to **Document**, to search throughout your Freeway document, **Story** to search the item or linked HTML items containing the insertion point, or **Item** to search a single HTML or graphic item.
- In the **Find** box type the text you want to search for.

By default Freeway searches forwards from the current insertion point.

- Select **Wrap Around** to continue searching from the beginning of the range once you have reached the end of the range.

By default **Ignore Case** is selected, so site and Site are treated as equivalent.

- Deselect **Ignore Case** to search for exactly what you typed.
- Select **Words Only** to match what you typed only as complete words, not within longer words.

**To replace text**

- Open the **Edit** menu and choose **Find/Replace**, then choose **Replace…** from the submenu.

The **Replace** dialog box includes an additional **Replace with** field:

- Type the replacement text in the **Replace with** box.
- Click the **Replace** button to replace the next occurrence, or the **Replace All** button to replace all occurrences in the specified range and direction.
To continue finding or replacing

- Select Keep Dialog Open to leave the Find or Replace dialog box on the screen as you search so you can keep clicking the Find button to find further occurrences.

Alternatively open the Edit menu and choose Find/Replace, then choose Find Next or Replace Next on the submenu to find or replace the next occurrence.

Checking your spelling

Freeway includes a spelling checker which highlights each suspect word in the Freeway document, and where possible suggests alternative spellings.

To check spelling

- Open the Edit menu and choose Spelling....
- Choose Document from the Check pop-up menu to check the entire Freeway document, Story to check the item or linked HTML items containing the insertion cursor, or Item to check just the currently selected HTML or graphic item.
- Click the Start button to start checking.

The most likely suggestion is provided in the Change to box.

Alternatively you can select one of the other suggestions by clicking it in the Suggestions list.

- Click the Change button to change the unknown word to the selected word.
- Click the Ignore button to ignore the unknown word and continue checking.

Change All and Ignore All apply the corresponding option to all subsequent occurrences of this word in the document.

- Click the Add button if the unknown word is correct and you want to add it to your user dictionary so it will not be flagged in future spelling checks.
Applying effects to graphic text

When you are formatting text in a graphic item, or GIF text in an HTML item, Freeway lets you apply a range of powerful text effects including a drop shadow, glow, background color, filter effect, outline, and shape effect.

You can combine effects for impressive results, and your text remains editable at every stage so you can make changes to the wording of your site without needing to manually rework the graphics.

Note: Graphic text effects are handled differently in the Freeway 4 Express Inspector palette. Please refer to page 22 of the Freeway 4 Express ‘Getting Started’ guide.

• Click the paintbrush icon at the top of the Inspector palette to display the text effect options:

To add a shape effect

• Click ▶ next to the Shape heading to expand the Shape section of the Inspector palette.
• Choose the effect from the Shape Effect pop-up menu.

Crack adds random cracks in the characters:

Wobble adds a random wobble to the outline of the characters:

You can adjust the size, spacing, and depth of the cracks using the corresponding sliders:
To add a drop shadow to the text

- Click the Shadow checkbox and click the ▶ to the left of the Shadow heading to display the shadow options:

  - Choose the color for the drop shadow using the Color pop-up menu, and its opacity with the Opacity slider.
  - Leave Global checked if you want this drop shadow to use the global angle for the page. Changing the Angle then affects all global lighting effects. Alternatively uncheck Global to specify the angle for this drop shadow independently.
  - Specify the angle of illumination by dragging the pointer on the Angle control.
  - Use the Offset slider to specify the offset for the drop shadow, and the Blur slider to blur the drop shadow.

Shadow

To add an outer glow

- Select the Glow checkbox and click the ▶ to expand the Glow section of the Inspector palette:

  - Choose the color for the glow from the Color pop-up menu, and adjust its opacity, spread, and blur using the corresponding sliders:

Outer glow

To add a background color to the text

- Select the Background checkbox and click the ▶ to expand the Background section of the Inspector palette:
• Choose the color of the background from the Color pop-up menu and adjust its opacity using the Opacity slider:

**Background**

**To change the text color**
• Click the ▶ next to the Text heading to display the text options:

  • Choose the text color from the Color pop-up menu.
  • Choose the draw option by clicking the appropriate button: Draw Solid, Draw Border Only, or Draw Solid and Thicken.

For the last two options select the border thickness from the pop-up menu.

  • Use the Opacity slider to change the opacity of the text:

**Emboss**

**Blur**

**Scatter**

**To add an overlay to the text**  
Freeway 4 Pro Only
• Select the Overlay checkbox and click ▶ to expand the Overlay section of the Inspector palette:

• Click the button to select the Draw option, and choose a color for the overlay from the Color pop-up menu.
Working with styles

Freeway 4 Pro Only

Freeway allows you to save a particular combination of text formatting settings and give them a memorable name, such as Mainheading. You can then apply the same settings to other selections of text simply by selecting the style you have defined from the Styles and Colors palette.

Styles provide a convenient way of ensuring consistency throughout your Web site by allowing you to apply a predefined group of settings in a single operation. In addition, if at a later date you decide to change the design of your site, you can simply edit the definition of a style, and any text defined with that style will immediately be updated to reflect the change.

Attributes

Each style consists of a list of attributes, such as Font, Size, and Align. The attributes are divided into CSS attributes and graphic attributes, and into character attributes and paragraph attributes.

CSS and graphic attributes

CSS attributes are applied to text in HTML items. Graphic attributes are applied to text in graphic items, and GIF text in HTML items.

You can choose which attributes to view by choosing CSS Attributes, Graphic Attributes, or CSS and Graphic Attributes from the View pop-up menu at the bottom of the Edit Style dialog box.

When an attribute, such as Font, has different options for CSS text and graphic text, the Edit Style dialog box shows two controls to allow you to set each option independently:

Character and paragraph attributes

In the Edit Style dialog box the attributes are divided into Character and Paragraph sections.

Character attributes can be applied to individual characters in a section of text.

Paragraph attributes apply to the whole paragraph, or all characters in the paragraph.
In addition, the Graphic Attributes include a Graphic Text Effects section listing text effect attributes which can be applied to characters within graphic text:

The Add Style dialog box will be displayed to allow you to define the new style:

- Enter a name for the style in the Name box.
- To specify the HTML tag to be used for text in this style optionally enter the tag in the Tag field.

You can choose a predefined tag from the pop-up menu.

For example, to use one of the standard HTML heading tags enter the appropriate tag h1, h2, or h3 in the Tag box. This ensures that visitors to your site with older browsers that do not support CSS styles will see the text in an appropriate weight of heading.
• To define character formatting for the style click the + to the right of the **Character** heading, then choose the character attribute you want to define from the pop-up menu:

A control will be added to the **Character** section to allow you to set the value of the attribute:

• Repeat for any other character attributes you want to define for the style.

You can remove an attribute by clicking the – to the right of the attribute in the **Character** section of the **Add Style** dialog box.

• To define paragraph formatting for the style click the + to the right of the **Paragraph** heading and choose the paragraph attribute you want to define from the pop-up menu:
A control will be added to the Paragraph section of the Add Style dialog box to allow you to set the value of the attribute:

To define a style based on existing text

Freeway 4 Pro Only

If you have already formatted text using the menus and the options in the Inspector palette, you can create a named style based on this formatting.

Freeway creates a temporary style for each new combination of formatting you define in your site, with a name such as .style1, .style2, etc., and these are listed in the Styles panel of the Styles and Colors palette below the permanent styles.

- Click the temporary style while holding down Ctrl and choose Edit Style... from the pop-up menu:

The Edit Style dialog box will be displayed to allow you to edit the definition of the style.

- Enter a name for the style and select Permanent to make it a permanent style.
- Proceed as for defining a new style above.

To apply a style to text

Freeway 4 Pro Only

- Select the text and click the style name in the document styles panel of the Styles and Colors palette.
Working with style sheets

Freeway 4 Pro Only

Freeway allows you to create multiple style sheets in your document. For each page you can then specify which style sheet should be used for the text on that page.

For example, if your site is divided into different sections, each with a different theme, you could create a separate style sheet defining the styles used in each section.

To manage the styles in your document

Either:

• Open the Edit menu and choose Styles….

Or:

• Click the options icon at the top right of the Styles and Colors palette and choose Edit Styles... from the pop-up menu:

The Edit Styles dialog box shows a list of the style sheets, and styles within each style sheet, and allows you to edit the definition of individual styles.

To show the styles within a style sheet

Freeway 4 Pro Only

• Click ▶ to the left of the style sheet name in the list on the left of the Edit Styles dialog box.

Initially there is one style sheet called sheet1, but you can create additional style sheets using the options pop-up menu below the list.

To display the definition of a style

Freeway 4 Pro Only

• Select the style in the left-hand list.

Its definition will be displayed to the right allowing you to edit attributes, add new attributes, or delete attributes:

You can edit, add, or delete attributes in the same way as for adding a new style described earlier.
• Click the Select button to display a complete list of all the Character, Graphic Text Effect, and Paragraph attributes, from which you can add attributes by clicking the corresponding checkboxes:

**To add a style** Freeway 4 Pro Only

• Click the + button below the list, and then specify the attributes of the new style to the right in exactly the same way as for creating a new style.

To delete a style Freeway 4 Pro Only

• Select the style in the left-hand list and click the – button.

If the document contains text in the style you are deleting, the following dialog box allows you to specify one of the remaining styles to apply to that text:

• Select the style you want to use, or [No Style] to leave the text without a style, and click the OK button.

To select the style sheet used for a page

Freeway 4 Pro Only

• Make sure no items are selected on the page.

• Click the page icon at the top of the Inspector palette to display the general page settings.

• Choose the style sheet you want to use from the Style Sheet pop-up menu:
When you change style sheets the attributes of any text on the page will change to reflect the settings of the matching styles in the new style sheet.
This chapter describes the options for working with graphics on your Web pages. It explains how to import and manipulate graphics, and add effects to graphics to create impressive results entirely within Freeway.
Using graphics on your Web pages

Editable graphics

Freeway allows you to import images in a wide range of formats, and then manipulate them in Freeway to achieve the exact effect you want. You can crop, scale, or transform graphics in a variety of ways and add a range of effects to them.

Freeway 4 Express can import the following file formats as editable graphics:

- GIF (Graphics Interchange Format)
- JPEG (Joint Photographic Experts Group)
- PNG (Portable Network Graphics)
- PICT (a standard Mac graphics Format)
- PDF (Portable Document Format)

In addition, Freeway 4 Pro supports the following formats:

- TIFF (Tagged Image File format)
- Adobe Photoshop (PSD)
- Adobe Illustrator
- BMP (Windows Bitmap)
- EPS (Encapsulated PostScript)
- QDGX (a legacy Mac graphics format)
- Any format for which you have Photoshop Import/Export plug-ins.

When you publish the site Freeway exports the graphics in one of the Web graphic formats: GIF, JPEG, or PNG, optimizing each graphic to achieve the best compromise between image quality and download time. You can either leave Freeway to select the most appropriate graphics format and export settings, or you can manually choose the settings individually for each graphic.

The following table gives the pros and cons of each export format:

<table>
<thead>
<tr>
<th>Format</th>
<th>Pros and cons</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIF</td>
<td>Recommended for simple graphics containing a limited range of colors, such as diagrams or graphic text.</td>
</tr>
<tr>
<td>JPEG</td>
<td>Recommended for photographic and other continuous tone images.</td>
</tr>
<tr>
<td>PNG</td>
<td>A recent alternative to GIF, with support for 8-bit transparency, but not supported by older browsers.</td>
</tr>
</tbody>
</table>

Pass-through graphics

If you have prepared a series of graphics in an external paint program so that they are already optimized for Web display, you can add them to the site as pass-through graphics so that they are exported unchanged when you publish the site. Pass-through graphics cannot be scaled or transformed, or have effects applied to them.
Creating graphics

**To create a rectangular graphic item**
- Click the Graphic icon in the toolbar:

![Graphic icon]

• Drag to draw a rectangle defining the size and position of the graphic item on the page.

The graphic item will be selected, as indicated by the selection handles on its border:

![Selected rectangle]

**To create an oval graphic item**
- Click the Oval icon in the toolbar:

![Oval icon]

• Drag to draw a rectangle defining the size of the oval.

When you import a graphic into the oval graphic item it will be cropped to the oval outline:

![Cropped oval]

**To create a graphic item with an arbitrary outline**
- Click the Path icon in the toolbar:

![Path icon]

• Click with the tool to draw successive points on the path, or drag to extend handles from the points to create a smooth curve outline.
• Click again on the first point to complete the outline:
To import a graphic into a graphic item

- Select the graphic item.
- Open the File menu and choose Import....
- Select the image you want to import:
  
  - To import the image as a pass-through graphic select Pass-through.
  - Click the Open button to import it.

The image will be shown in the graphic item:

Note: It is good practice to move any images you want to use on your site into a Media folder, within your Site folder, before importing them into the site. This ensures that you will have the original master versions of each image available when you publish the site. If you import images from other locations, such as your desktop, there is a risk that they will subsequently get moved or deleted, with the result that Freeway will not be able to locate them when you next publish the site.

To drag and drop a graphic

You can simply drag graphics from a Finder window and drop them onto your Freeway document:

- Drag the graphic from a Finder window, such as the Media folder.
- Drop it onto the page in your Freeway document, or into a graphic item:

If you drop the graphic into a graphic item it will be cropped to fit the item.

If you drop the graphic onto the page, a new graphic item will be created the correct size for the graphic you have imported.
To import a graphic as a pass-through graphic

- Select Pass-through in the Import dialog box and click the Open button to import it.

To drag and drop a graphic as a pass-through graphic

- Drag the graphic and drop it onto a page or graphic item, holding down Option before you release the mouse button.

To delete a graphic from a graphic item

- Select the graphic item, then open the Edit menu and choose Clear Content.

Alternatively, importing or dragging and dropping another graphic onto the same graphic item will replace the original graphic in the item.

Manipulating graphic items

You can manipulate graphic items in a variety of ways, including: resizing, cropping, panning, and transforming them.

With pass-through graphics the graphic item needs to be the correct size for the graphics. If the graphic item is too small to display the graphic it will be displayed as a blue cross and will not be exported when the site is published.

To resize a graphic item

- Drag the graphic item by one of its selection handles using the Select tool:

![Resizing graphic](image)

When you release the mouse button the graphic will be resized:

![Resized graphic](image)

You can constrain the graphic item to a square by holding down Shift, or resize the graphic preserving the aspect ratio by holding down Shift.

By default, resizing a graphic item does not affect the size and position of the graphic it contains. Alternatively, you can specify the resizing behavior; see Resizing graphics, page 59.
To fit or scale a graphic within the graphic item

- Select the graphic item.
- Open the Item menu, choose Graphic, then choose one of the following options from the submenu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Size</td>
<td>Scales the graphic to the original size.</td>
</tr>
<tr>
<td>Fit Box to Graphic</td>
<td>Scales the graphic item to fit the current size of the graphic.</td>
</tr>
<tr>
<td>Center</td>
<td>The graphic is centered within the graphic item.</td>
</tr>
<tr>
<td>Scale to Box</td>
<td>The graphic is scaled to the size of the graphic item.</td>
</tr>
<tr>
<td>Scale and Pad</td>
<td>The graphic is scaled to the size of the graphic item keeping its original proportions.</td>
</tr>
<tr>
<td>Scale Up</td>
<td>The graphic is enlarged by 5% within the graphic item.</td>
</tr>
<tr>
<td>Scale Down</td>
<td>The graphic is reduced by 5% within the graphic item.</td>
</tr>
</tbody>
</table>

To position a graphic numerically

- Select the graphic item.
- Open the Item menu and choose Modify..., or double-click the graphic item.

The Graphic dialog box displays information about the graphic.

- Click the Graphic tab and enter the required horizontal and vertical offset values:

The offsets are measured from the top left corner of the graphic item.

To transform a graphic item

- Select one of the transform tools (Important: only Rotate is available in Freeway 4 Express):
• Click the item to display the resize handles on its border.
• Drag one of the resize handles to transform the item:

![Image of a graphic item with resize handles]

• When you release the mouse button the item will be redrawn transformed:

![Image of a transformed graphic item]

To transform a graphic item numerically

Freeway 4 Pro Only

• Select the graphic item.
• Open the Item menu and choose Transform....

The following dialog box allows you to specify a transform for the item and/or its content:

![Transform dialog box]

Resizing graphics

For each graphic item you can specify what happens to the content when its graphic item is resized. The four options are explained in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Example</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve Size</td>
<td>![Image of a graphic item]</td>
<td>Resizing the graphic item does not affect the size or position of the graphic it contains.</td>
<td>ctrl</td>
</tr>
<tr>
<td>Scale Graphic</td>
<td>![Image of a graphic item]</td>
<td>The graphic is scaled to match the graphic item.</td>
<td></td>
</tr>
<tr>
<td>Scale and Pad</td>
<td>![Image of a graphic item]</td>
<td>The graphic is scaled, and padded with space to preserve its original aspect ratio.</td>
<td>⌃ ⌨</td>
</tr>
<tr>
<td>Scale and Trim</td>
<td>![Image of a graphic item]</td>
<td>The graphic is scaled to fit the graphic item, if necessary cropping the graphic in one dimension to preserve the aspect ratio.</td>
<td>⌃</td>
</tr>
</tbody>
</table>

You can set the resizing behavior permanently for the graphic item as described below, or you can set it temporarily while resizing the graphic item by holding down the modifier key(s) shown in the Keys column in the above table.

To set the resizing behavior

• Select the graphic item.
• Open the Item menu and choose Modify....
• In the Graphic dialog box click the Graphic tab.
Adding effects to graphics

Freeway allows you to add a range of effects to graphics including: drop shadow, outer glow, background color, foreground color, and border.

In conjunction with the transformations these effects enable you to create complex graphic composites entirely within Freeway, without needing to use another paint program, and with the flexibility of being able to alter your artwork at any stage.

**Note:** Graphic effects are handled differently in the Freeway 4 Express Inspector palette. Please refer to pages 20–22 of the Freeway 4 Express ‘Getting Started’ guide.

- Choose the sizing option from the **Sizing Behavior** pop-up menu:

![Sizing Behavior Pop-up Menu]

After selecting a graphic item, you can access the Inspector palette to display appearance settings:

![Inspector Palette]

The individual settings are described in the following sections.
To apply a crack or wobble effect to the graphic

- In the Shape Effect section choose Crack or Wobble from the Effect pop-up menu:

The Crack effect provides controls to allow you to adjust the period, randomness, gap, and depth of the cracks.

The Wobble effect provides controls to allow you to adjust the period, randomness, deviation, and smoothness of the wobble:

To add a drop shadow

- In the Shadow section select the Shadow checkbox:

Choose the color for the drop shadow using the Color pop-up menu, and its opacity with the Opacity slider.

- Leave Global checked if you want this drop shadow to use the global angle for the page. Changing the Angle then affects all global lighting effects. Alternatively uncheck Global to specify the angle for this drop shadow independently.

- Specify the angle of illumination by dragging the pointer on the Angle control.

- Use the Offset slider to specify the offset for the drop shadow, and the Blur slider to blur the drop shadow:
To add a glow to the graphic

- In the Glow section select the Glow checkbox:

- Choose the color for the glow from the Color pop-up menu.
- Use the Opacity, Spread, and Blur sliders to adjust the characteristics of the glow:

To set the background color

- In the Background section choose the background color from the Color pop-up menu:

If the graphic has a transparent background the fill color will show through:

To set the foreground color [Freeway 4 Pro Only]

- In the Foreground section choose the color from the Color pop-up menu:
A graphic item with a foreground color will tint text in a graphic item below it:

**Foreground**

### To add a border around the graphic

- In the **Border** section select the **Border** checkbox:

- Choose the color for the border from the **Color** pop-up menu.
- Specify the thickness of the border using the **Size** pop-up menu and the border dash pattern using the **Dash** pop-up menu.

- For solid borders you can specify the position of the border relative to the graphic rectangle by choosing **Outside**, **Center**, or **Inside** from the **Position** pop-up menu.
- Add a filter effect to the border by choosing **Emboss**, **Blur**, or **Scatter** from the **Filter** pop-up menu, and use the controls to adjust the filter effect.

### Combining graphics

If you create two overlapping non-layer graphic items, by default Freeway combines them into a single graphic large enough to contain both items when you preview or publish the site, as indicated by the blue rectangle enclosing the items:

In some situations you may prefer to export overlapping graphics as separate graphics. For example, if one graphic contains a photographic image and the other contains text, you may want to set the output type to JPEG for the image and GIF for the text.
To specify the output settings for combined graphics

- Click the output settings icon at the top of the Inspector palette to display the item output settings.

If one or more combined graphics are selected, a separate Combined Graphic section shows the output settings for the combined graphics:

To export overlapping graphics separately

- Select one of the overlapping graphics.
- Click the general settings icon at the top of the Inspector palette to display the item general settings.
- In the Properties section uncheck Combine Graphics:

You can now set the output settings for each graphic independently.

Controlling how graphics are exported

By default Freeway exports graphic items with 256 colors or less in GIF format, and with more than 256 colors in JPEG format. However, you can specify the export format explicitly for any item and, if required, specify the individual parameters determining how the graphic is exported when you publish the site.

To set the export options

- Select the graphic item.
- Click the output settings icon at the top of the Inspector palette to show the item output settings:

For more information about the export settings for each of the graphics formats refer to the Freeway Reference guide.
To specify the alt text

It is good practice to set meaningful alt (or alternative) text for each of the graphics on your site. This is displayed to users who choose not to display the graphics, and provides information that can help your site get indexed by search engines.

By default the alt text is set to the name of the graphic.

- Edit the text in the Inspector palette to specify different alt text:

![Inspector palette](image)

To import a multimedia file

Either:

- Drag the file from a Finder window, and drop it onto the page.

An HTML item will be created the correct size for the content.

Or:

- Click the HTML icon in the toolbar and drag to draw a rectangle.
- With the item still selected, open the File menu and choose Import....
- Select the multimedia file you want to import and click the Open button to import it.

If the plug-in content is supported by QuickTime the HTML box will show a preview of the content; otherwise it shows a plug-in icon with the associated file name:

![Plug-in icon](image)

When the site is published, the file you specified will be copied into your site folder.

For each type of content the item output settings panel of the Inspector palette allows you to set specific options to determine how the content is played.

Using multimedia

Freeway allows you to incorporate movies and animations in a range of standard formats, including:

- Movies in QuickTime format, created by applications such as Adobe Premiere, Apple Final Cut Pro, and iMovie.
- Animations in Macromedia Shockwave format created using applications such as Macromedia Director, Flash, or FreeHand.

Both formats are widely used on the Web, and although Web browsers require plug-ins to display them, most users will already have these installed.
To set options for a QuickTime movie

- Select the HTML item containing the movie.
- Click the output settings icon at the top of the Inspector palette to display the item output settings:

  - Select Autoplay to play the movie automatically when the page is loaded.
  - Set Loop to No to play the movie once, Yes to loop the movie, or Palindrome to play the movie forwards and then in reverse repeatedly.

To display the QuickTime movie controller

- Select Controller on the output settings panel of the Inspector palette.
- Open the Item menu, choose Graphic, then choose Fit Box to Graphic from the submenu to make the HTML item the correct size to include the controller:

When the movie is displayed in a Web browser a controller will be provided to allow the user to control playback manually:

To set the options for Flash animations

- Select the HTML item containing the Flash animation.
- Click the output settings icon at the top of the Inspector palette to display the item output settings:

  - Select Loop to play the animation repeatedly.
  - Select Play to play the animation automatically when the page is loaded.
  - Choose the quality from the Quality pop-up menu.
Managing resources

The Resources dialog box contains a list of all the graphics and other content files that are used in the current document. This dialog displays information about each individual graphic and allows you to delete, update, and resample graphics. You can also define whether a particular graphic will be exported when the Web page is published.

To display the resources

- Open the Edit menu and choose Resources…:

The Resources dialog box shows the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>What it shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>The file name, with the option of showing the location. Use the pop-up menu to display the graphic’s file name only, or its full file path.</td>
</tr>
<tr>
<td>Type</td>
<td>The file type.</td>
</tr>
<tr>
<td>Status</td>
<td>OK if the graphic is up to date, Missing if the file is not present, or Modified if the file is not current.</td>
</tr>
<tr>
<td>Page</td>
<td>The page on which the graphic appears.</td>
</tr>
</tbody>
</table>

To update all the graphics in the document

- Click the Update All button.

This updates the preview images shown on your Freeway pages for any graphics you have modified outside Freeway.

To resample graphics to their current size

- Click the Resample All button.

This redraws the preview images, improving the appearance of any graphic items you have scaled or transformed.

To edit, show, or delete a graphic

- Select a graphic from the list and click the Show button to display the graphic.
- Select a graphic from the list and click the Edit button to display the Graphic File dialog box for that graphic.
- Select a graphic from the list and click the Delete button to delete a graphic.
Publish problems

If Freeway cannot locate one or more of the original resource files when you publish or preview the site, the following Publish Problems warning is displayed:

![Publish Problems dialog box]

You can then take one of the following actions:

**To provide a graphic if the file has moved**

- Click the Edit Resources... button in the Publish Problems dialog box to display the Resources dialog box.

  The missing graphic will be shown as Missing in the Status column.

  - Select the missing file, click the Edit... button, then click the Locate... button and locate the file in its new location.

To print a list of the missing graphics as a text file, click the Save... button in the Publish Problems dialog box. This is useful if, for example, you have to retrieve several missing files from an archive.

**To provide a graphic if the file is permanently lost**

- Click the OK button in the Publish Problems dialog box to publish the site using the preview image for the missing graphic. This may give acceptable quality.

You can export the preview image, using the Export command on the File menu, and then link this file to avoid getting the Publish Problems warning in future.
This chapter describes the options for creating tables within Freeway, editing tables, and specifying their appearance.
Creating tables

Tables provide a convenient way of presenting information in a grid of regular rows and columns. Each cell in a table can contain text, graphics, or a combination of the two.

You can change the width of the rows and columns independently, and control the appearance of the table in a variety of ways including the thickness of the border between cells, and the color of the table or cell backgrounds.

You can choose how information is aligned within each cell, and you can merge two or more adjacent cells to create cells which straddle multiple rows or columns.

To create a table

Either:

• Click the **Table** icon in the toolbar:

    ![Table Icon]

• Drag to draw a rectangle on the page.

Or:

• Open the **Insert** menu and choose **Table**....

In either case the following **Insert Table** dialog box is displayed to allow you to specify the number of rows and columns:

    ![Insert Table Dialog]

• Enter the number of rows and columns, and optionally change the **Border**, **Cell spacing**, and **Cell padding**.

These are explained later in the chapter.

• Click the **OK** button to create the table:

Note that you can add or delete rows or columns at a later date if you need to.

To type HTML text into a table cell

• Double-click in the table cell with the selection pointer to position the insertion bar in the cell.

• Type the text into the cell just as you would with an HTML item.
To import text into a table

You can import tab delimited, comma delimited, or space delimited text into a table. The fields will be formatted into successive cells, automatically expanding the size of the table if necessary to accommodate the items.

• Double-click to position the insertion point in the first cell you want to import items into.
• Open the File menu and choose Import Text....
• In the Import dialog box select the delimited text file you want to import into the table, and choose the format from the Import pop-up menu:

If the table is not large enough to accommodate the data the following dialog box will give you the option of expanding it or truncating the data:

• Click the OK button to expand the table, or the Truncate Text button to ignore data outside the current size of the table.

Moving and resizing tables

Freeway allows you to move or resize an entire table, or resize individual rows or columns.

These operations can be performed either by directly manipulating the table, or by editing parameters in the appropriate panel of the Inspector palette for the table.

To move a table

• Position the Select tool anywhere within the table until the cursor changes to a hollow pointer.
• Drag to move the table to the new position.
To resize a table

- Point to the border of the table with the Select tool until the cursor changes to a hollow pointer, then click to display the table’s selection handles.

- Drag the border of the table by one of the selection handles to resize it.
- Hold down Shift to constrain the table to a square, or Shift Option to keep the proportions constant.

All the rows and columns in the table will be resized in proportion.

To move or resize a table numerically

- Select the table.
- Click the general settings icon at the top of the Inspector palette to display the item general settings.
- In the Dimensions section edit the X, Y, W, and H fields to specify the position and size of the table:

Selecting cells

To select one or more cells in a table

- Click the first cell with the Select tool.

The cell will be highlighted with a thick border to indicate that it is selected:

If you want to select additional cells:

- Hold down the Shift key and click the additional cells you want to select.

They are indicated by a lighter thick border:

To select an entire row or column

- Move the mouse pointer over the top of the column or the left-hand edge of the row until the cursor changes to a small solid arrow:

- Click to select the entire column or row.
• Hold down **Shift** and click again to select an additional column or row.

**To select all the cells in the table**

• Select one cell as described above.
• Open the **Edit** menu and choose **Select All**.

**Resizing rows or columns**

**To resize a row or column**

• Using the **Select** tool, point to the border between two rows or columns until the cursor changes to the resizing cursor.
• Drag the border to the new position:

![Resizing rows or columns](image)

When you release the mouse button the row or column will be resized to the size you have specified, adjusting the size of the table to keep the size of the other rows and columns unchanged.

If you want to move the border between two rows or columns without changing the size of the table:

• Press the **Space** key while you are dragging the border, then release it after releasing the mouse button.

Note that if cells contain text they cannot be made smaller than the longest line of unbroken text.

**To resize rows or columns numerically**

• Select one or more cells in the table, as described above.

• Click the table cell icon at the top of the **Inspector** palette to display the table cell settings:

![Table cell settings](image)

• In the **Table Cell** section edit the **W** and **H** fields to specify the width and height of the table cell(s).
Editing tables

Freeway allows you to add or delete rows or columns, and split or join cells to form larger cells that span multiple rows or columns.

To insert rows or columns

- Select the table, or cells within the table.
- Open the Item menu, choose Table, then choose Insert Rows… or Insert Columns… from the submenu.

The following dialog box allows you to specify how many rows or columns to insert and where to insert them:

- Select Start of Table or End of Table to insert the new rows or columns at the start or end of the table.

If you have selected a cell within the table you also have the option of inserting new rows or columns before or after the selected cell.

- Select Before Selection to insert the new rows or columns before the selected cell, or After Selection to insert them after the selected cell.
- Click the OK button to add the rows or columns you have specified.

To add a row or column by dragging within a table

- Using the Select tool, point to the border between two rows or columns until the cursor changes to a resizing cursor.
- Drag the border to indicate the size and position of the new column, and while dragging the mouse button press Option to create the new column.

To delete rows or columns

- Select one or more cells in the table.
- Open the Item menu and choose Table, then choose Delete Row or Delete Column from the submenu.

The rows or columns indicated by the cell or cells you have selected will be deleted.

Joining and splitting cells

You can combine two or more cells into a single cell that spans multiple rows or columns. This is useful to create headings across a table, or provide information that applies to several rows or columns in a table:
To join two or more cells

- Select the cells you want to join, in Selecting cells, page 72.
- Open the Item menu and choose Table, then choose Join Cells from the submenu.

The array of cells defined by the cells you selected will be combined into a single cell, with the settings and contents of the first cell you selected.

To split a cell

- Select the cell.
- Open the Item menu and choose Table, then choose Split Cells from the submenu.

The following dialog box allows you to specify how you want to split the cell:

Specifying the appearance of tables

To specify the cell border, spacing, and padding

- Select the table.
- Click the general settings icon at the top of the Inspector palette to display the item general settings.

The Cells section shows the number of rows and columns, and the border, spacing, and padding settings:

The following table shows the meanings of the Cell parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border</td>
<td>The thickness of the border around the outside of the entire table.</td>
</tr>
<tr>
<td>Cell spacing</td>
<td>The thickness of the border between rows and columns.</td>
</tr>
<tr>
<td>Cell padding</td>
<td>The offset between the border and the content of each cell.</td>
</tr>
</tbody>
</table>
To specify the color of a cell

- Select one or more cells.

Either:

- Click the color in the Styles and Colors palette Freeway 4 Pro Only.

Or:

- Click the table cell icon at the top of the Inspector palette to display the table cell settings.
- In the Table Cell section choose the color from the Color pop-up menu:

The cell(s) will be colored:

To set a color for the entire table

- Select the table.

Either:

- Click the color you want to use in the Styles and Colors palette Freeway 4 Pro Only.

Or:

- Click the general settings icon at the top of the Inspector palette to display the table’s general settings.
- Choose the color from the Background pop-up menu:

The table will be colored:
This chapter describes how to create forms in Freeway to allow visitors to your sites to enter information and submit it to your server. It describes each of the form tools, and explains how to define the action of the form.
What are forms for?

A form allows a visitor to type information onto a Web page and submit it to your server so you can take appropriate action. You can use a form to request a user’s name and email address, ask them to vote for their favorite item from a list, or allow them to make an on-line order. In each case the visitor provides information and then clicks a Submit button to submit it.

The information is sent to the server, where it is usually processed by a form-processing script. This script typically returns a page to the user’s browser that confirms that the information was received successfully.

Using forms

To use a form on your Web site you need to provide a script that will handle the information sent back from the completed form. The creation of form-processing scripts is outside the scope of this manual, and if you are publishing your site through an Internet Service Provider you should contact them to see what options are available.

Creating a form

To create a form on your Web page you simply design a form, using the form items available from the Freeway toolbar. You then specify what the form should do using the Form set-up dialog box.

To design a form

- Click and hold the HTML icon in the toolbar to display a pop-up menu of tools:

- Select the form tool you want to use.

- Drag to draw a rectangle defining the position and size of the form item:

- Click the output icon at the top of the Inspector palette to edit the item’s parameters:
The parameters available depend on the particular form item you have created. For more information about each form item see the following sections.

Note: You can put form items into a table to create a grid layout.

**Button**

Allows the user to submit the form, clear the form, or perform some other action.

![Submit](image)

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the parameter sent to the form script.</td>
</tr>
<tr>
<td>Value</td>
<td>The label of the button, and the value sent to the form script.</td>
</tr>
<tr>
<td>Type</td>
<td>Submit creates a button that submits the form. Reset creates an optional button that resets the form items on the form. Button creates a button that can be used to execute a JavaScript command.</td>
</tr>
</tbody>
</table>

To use a graphic as a submit button  **Freeway 4 Pro Only**

Instead of providing a Submit button on a form you can use a graphic item as a submit button.

![Add to Cart](image)

- Select the graphic item.

- Click the output icon at the top of the Inspector palette to display the item output settings.

- Select Submit and enter the value for the button:

![Graphic Item](image)

When the user clicks the graphic item two parameters will be sent to the form script indicating the coordinates of the point where the user clicked; for example:

AddToCart.X 35
AddToCart.Y 8
Checkbox

Allows the visitor to select any from a series of options:

Please send me information about your following products:

- □ Perfumes
- □ Soaps
- □ Bath Oils

It provides the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The parameter name used to identify the checkbox to the form script. Each checkbox on a form should be given a unique name.</td>
</tr>
<tr>
<td>Value</td>
<td>The value sent to the form script when the control is checked.</td>
</tr>
<tr>
<td>Text</td>
<td>The label for the checkbox.</td>
</tr>
<tr>
<td>Checked</td>
<td>The default state of the checkbox.</td>
</tr>
</tbody>
</table>

Radio button

Allows the visitor to select one of a number of mutually exclusive options:

Do you agree that children should be allowed to vote:

- Yes
- No
- Don’t Know

Each set of radio buttons is called a ‘cluster’. Selecting one radio button in a cluster automatically deselects all the other buttons in the cluster.

Menu/List

Allows the user to select an item from a list of items.

The items can be displayed as a pop-up menu:

This will appear in the browser like this:

Language: English, French, German
Alternatively the items can be displayed as a scrolling selection list, allowing the user to see several options, and optionally select more than one option at a time:

![Pets owned:](image)

This will appear as follows:

Pets owned:  

Cat  
Dog  
Rabbit  
Iguana

The following parameters are provided:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the parameter sent to the form script.</td>
</tr>
<tr>
<td>Size</td>
<td>Set this to 1 for a pop-up menu, or greater than 1 for a scrolling list of items.</td>
</tr>
<tr>
<td>Multiple</td>
<td>When checked allows multiple items to be selected.</td>
</tr>
<tr>
<td>Choice</td>
<td>An optional label used to identify a choice in the menu or list.</td>
</tr>
<tr>
<td>Value</td>
<td>The value returned to the form script if the user selects this choice. If no value is specified the name of the choice is returned.</td>
</tr>
<tr>
<td>Initially selected</td>
<td>Identifies one or more values that should be initially selected by default.</td>
</tr>
</tbody>
</table>

To add a choice to a pop-up menu or list
- Click the New item icon at the bottom left of the Inspector palette:

![Menu/List](image)

The Edit Choice dialog box allows you to specify the choice, value, and indicate whether the choice should initially be selected:

![Edit Choice](image)

- Enter values for the options as required and click the OK button to add the choice.

To edit a choice
- Double-click the choice, or select the choice in the list of choices and click the Edit item icon:
To delete a choice
• Select the choice in the choice list and click the Delete item icon:

To change the order of items in the list
• Select an item and click the ↑ or ↓ button to change its position in the list.

Text field
Allows the user to enter one line of text.

In most browsers if the user presses Enter in a text field it submits the form.

The following parameters can be specified for a text field:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The parameter submitted to the form script.</td>
</tr>
<tr>
<td>Value</td>
<td>A default value that can optionally be displayed in the field.</td>
</tr>
<tr>
<td>Password</td>
<td>Hides the text typed by the user, for password fields.</td>
</tr>
<tr>
<td>Maximum length</td>
<td>Specifies the maximum number of characters that can be entered into the field; for no limit put 0.</td>
</tr>
<tr>
<td>Size</td>
<td>The width of the field.</td>
</tr>
</tbody>
</table>

Text area
Allows the user to enter multiple lines of text. If necessary, scroll bars are displayed to allow the user to scroll through the text they have entered.

This will appear as follows:

It provides the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the parameter sent to the form script.</td>
</tr>
<tr>
<td>Text</td>
<td>Optional default text, which will be displayed as the initial contents of the field.</td>
</tr>
<tr>
<td>Wrap</td>
<td>Specifies whether the text should wrap within the field. This is normally ignored by browsers.</td>
</tr>
<tr>
<td>Rows, Columns</td>
<td>Specifies the dimensions of the field.</td>
</tr>
</tbody>
</table>
Setting up your form

Once you have designed the form controls on your form you need to specify the action to be taken when the user submits the form.

**To define the form action**

- Open the Page menu and choose Form Setup…

The Form Setup dialog box allows you to specify what happens when the user submits the form, add hidden fields to the form to pass additional information to the server, and add additional code to the form.

- Set the method to **POST** (the usual option), or **GET** (a less frequently used option that puts the form parameters and values as part of the URL).
- In the **Action** field specify the URL of the script designed to process the form.
- In the **Encoding** field you can optionally specify the form encoding.
- Click the **OK** button to set up the form.

**To specify hidden fields**

You can send additional information to the form script in hidden fields, which behave just like form controls but are not visible on the form. Each hidden field has a name, which is the parameter sent to the form script, and the value, which is sent as the parameter’s value.

For example, you might have a questionnaire consisting of several questions each with the answers **Yes**, **No**, or **Don’t know** on separate pages of your Web site. You could process each question using the same form script, and pass the number of the question in a hidden field.

**To define a hidden field**

- Click the **Hidden Fields** tab in the Form Setup dialog box.
- Click the **New…** button to define a new hidden field:
• Enter a name for the field and its value, and click the **OK** button to save the field.

Note that you should normally choose a unique name for each form control or hidden field on your form, so that the value of each item is sent to the form script as a separate parameter. If you do give several form controls the same name, the parameter will be set to a list of their values.
This chapter explains the function of actions in Freeway and gives detailed information about using the rollover, slave image, animation, pop-up window, navigation, and graphics actions to add impressive, dynamic effects to your site without any programming.

**Important:** Freeway 4 Express includes the actions listed in this section, but does not support third party actions.
What actions do

Actions are items that you can add to your Web pages to perform extra functions or create dynamic effects. Each action adds special HTML or JavaScript instructions to the page to achieve results that would normally require sophisticated programming on your part. Here are some examples of what actions can do:

**Dynamic buttons and text**

You can create dynamic buttons that change appearance when the user moves the mouse over them in the browser; this is called a rollover. Rollovers make the site visually dynamic and give the user useful feedback about where to click on the page.

**Slave images and layers**

The slave image and layer actions allow you to define items on a page that are shown or hidden when the user points to a graphic, or clicks a button or link.

**Pop-up windows**

A pop-up window can be opened automatically, or when the user clicks a graphic, button, or link. Pop-up windows are useful for providing subsidiary information relating to the main page.

**Animation**

The animation actions let you define events that happen automatically as the user is viewing the Web page, such as scrolling text, or animated graphics.

**Navigation**

The navigation actions allow you to provide alternative ways of navigating around your site instead of standard hyperlinks, including a navigation bar, site map, navigation map, and menu bar.

Image effects

Freeway provides a range of image effects that you can apply directly to graphics on the site, including blur, sharpen, color, brightness, and contrast corrections.

Summary of actions

The following table summarizes all the actions provided with Freeway:

<table>
<thead>
<tr>
<th>Category</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Link to New Window</td>
<td>Item</td>
<td>Displays a pop-up window when the user clicks a graphic item.</td>
</tr>
<tr>
<td></td>
<td>Pic to New Window</td>
<td>Item</td>
<td>Displays an image in a pop-up window.</td>
</tr>
<tr>
<td></td>
<td>Text Link to New Window</td>
<td>Object</td>
<td>Displays a pop-up window when the user clicks a text link.</td>
</tr>
<tr>
<td></td>
<td>Pop-up Window</td>
<td>Page</td>
<td>Displays a pop-up window when the page is opened.</td>
</tr>
<tr>
<td></td>
<td>Self Closing Pop-up Window</td>
<td>Page</td>
<td>Makes a pop-up window close automatically when the user browses to another page.</td>
</tr>
<tr>
<td></td>
<td>Blast Timer</td>
<td>Page</td>
<td>Sends a trigger to an item at a specified delay after the page is opened.</td>
</tr>
<tr>
<td></td>
<td>Random Rollover</td>
<td>Item</td>
<td>Reveals or hides graphic items and sends a random trigger when the user points to or clicks a graphic item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Name</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rollover</td>
<td>Item</td>
<td></td>
<td>Reveals or hides graphic items and sends a trigger when the user points to or clicks a graphic item.</td>
</tr>
<tr>
<td>Random Sequence</td>
<td>Page</td>
<td></td>
<td>Sends a random sequence of triggers after the page is opened.</td>
</tr>
<tr>
<td>Sequence Timer</td>
<td>Page</td>
<td></td>
<td>Triggers a sequence of items after the page is opened.</td>
</tr>
<tr>
<td>Text Rollover</td>
<td>Object</td>
<td></td>
<td>Triggers an item after the user points to or clicks a text link.</td>
</tr>
<tr>
<td>Slave</td>
<td>Slave Image</td>
<td>Item</td>
<td>Displays one of up to 20 images when triggered by another action.</td>
</tr>
<tr>
<td>Slave Load Frame</td>
<td>Page</td>
<td></td>
<td>Loads a page into a frame when triggered by another action.</td>
</tr>
<tr>
<td>Slave Show/Hide Image</td>
<td>Item</td>
<td></td>
<td>Shows or hides an image when triggered by another action.</td>
</tr>
<tr>
<td>Slave Show/Hide Layer</td>
<td>Item</td>
<td></td>
<td>Shows or hides a layer when triggered by another action.</td>
</tr>
<tr>
<td>Redirection</td>
<td>Timed Redirect</td>
<td>Page</td>
<td>Redirects the user to another page after a specified time delay.</td>
</tr>
<tr>
<td></td>
<td>Version Redirect</td>
<td>Page</td>
<td>Redirects the user to another page depending on the version number of their browser.</td>
</tr>
<tr>
<td>Layer</td>
<td>Move Layer</td>
<td>Item</td>
<td>Animates a layer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td>Country List</td>
<td>Object</td>
<td>Adds a menu of countries to a form.</td>
</tr>
<tr>
<td></td>
<td>Current Date</td>
<td>Object</td>
<td>Displays the current date.</td>
</tr>
<tr>
<td></td>
<td>Navigation Pop-up</td>
<td>Object</td>
<td>Allows the user to navigate to other pages by selecting them from a pop-up menu.</td>
</tr>
<tr>
<td></td>
<td>No Cache</td>
<td>Page</td>
<td>Prevents a page from being cached by the browser.</td>
</tr>
<tr>
<td>Content</td>
<td>Acrobat</td>
<td>Object</td>
<td>Downloads an Adobe Acrobat file when the user clicks a text link.</td>
</tr>
<tr>
<td></td>
<td>Acrobat Icon</td>
<td>Item</td>
<td>Downloads an Adobe Acrobat file when the user clicks a graphic item.</td>
</tr>
<tr>
<td></td>
<td>Background Sound</td>
<td>Page</td>
<td>Plays a sound when the page is loaded.</td>
</tr>
<tr>
<td></td>
<td>Director</td>
<td>Object</td>
<td>Embeds a director file in the page.</td>
</tr>
<tr>
<td></td>
<td>Download File</td>
<td>Object</td>
<td>Downloads a file when the user clicks a text link.</td>
</tr>
<tr>
<td></td>
<td>Download Icon</td>
<td>Item</td>
<td>Downloads a file when the user clicks a graphic item.</td>
</tr>
<tr>
<td></td>
<td>Flash Extras</td>
<td>Item</td>
<td>Embeds a Flash movie in the page.</td>
</tr>
<tr>
<td></td>
<td>QuickTime Extras</td>
<td>Item</td>
<td>Embeds a QuickTime movie in the page.</td>
</tr>
</tbody>
</table>
### Creating dynamic effects

<table>
<thead>
<tr>
<th>Category</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
<td>Menu Bar</td>
<td>Item</td>
<td>Allows you to define a menu bar for navigation based on a table item.</td>
</tr>
<tr>
<td>Navigation</td>
<td>Bar</td>
<td>Object</td>
<td>Automatically creates a navigation bar to allow the user to navigate to the other pages on the site.</td>
</tr>
<tr>
<td>Site Map</td>
<td>Object</td>
<td></td>
<td>Automatically creates a site map showing the structure of the site and allowing the user to navigate to any page.</td>
</tr>
<tr>
<td>Navigation</td>
<td>Map</td>
<td>Item</td>
<td>Allows you to convert an HTML item into a navigation map.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Buttons</td>
<td>Item</td>
<td>Converts a graphic item into a button with a 3D appearance.</td>
</tr>
<tr>
<td>Graphics</td>
<td>Advanced</td>
<td>Item</td>
<td>Applies a horizontal or vertical fade to an image.</td>
</tr>
<tr>
<td></td>
<td>Fade</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blur</td>
<td>Item</td>
<td>Blurs an image.</td>
</tr>
<tr>
<td></td>
<td>Chroma Key</td>
<td>Item</td>
<td>Makes specified colors in an image transparent to allow you to cut it out from its background.</td>
</tr>
<tr>
<td></td>
<td>Hue Rotate</td>
<td>Item</td>
<td>Changes the hue of an image.</td>
</tr>
<tr>
<td></td>
<td>Impress</td>
<td>Item</td>
<td>Gives an image an embossed appearance.</td>
</tr>
<tr>
<td></td>
<td>Linear Blur</td>
<td>Item</td>
<td>Applies a speed blur to an image.</td>
</tr>
<tr>
<td></td>
<td>Saturate</td>
<td>Item</td>
<td>Adjusts the color saturation of the image.</td>
</tr>
<tr>
<td></td>
<td>Sharpen</td>
<td>Item</td>
<td>Sharpens the image.</td>
</tr>
<tr>
<td></td>
<td>Solarize</td>
<td>Item</td>
<td>Gives an image the appearance of an overexposed or underexposed photograph.</td>
</tr>
<tr>
<td></td>
<td>Watermark</td>
<td>Item</td>
<td>Applies a selected graphic to an image as a watermark.</td>
</tr>
<tr>
<td></td>
<td>Duotone</td>
<td>Item</td>
<td>Converts the image to a two-color duotone or three-color tritone.</td>
</tr>
<tr>
<td></td>
<td>Fade</td>
<td>Item</td>
<td>Fades the image horizontally or vertically.</td>
</tr>
<tr>
<td></td>
<td>Fill Master</td>
<td>Item</td>
<td>Allows you to draw geometric shapes with graduated fills and borders within a graphic item.</td>
</tr>
<tr>
<td></td>
<td>Photo Frame</td>
<td>Item</td>
<td>Adds a frame effect to an image.</td>
</tr>
<tr>
<td></td>
<td>Photo Magic</td>
<td>Item</td>
<td>Provides a variety of image adjustments including color, brightness, and contrast.</td>
</tr>
<tr>
<td></td>
<td>Posterize</td>
<td>Item</td>
<td>Reduces the number of levels in an image.</td>
</tr>
<tr>
<td></td>
<td>Scan Lines</td>
<td>Item</td>
<td>Adds a mesh appearance to an image.</td>
</tr>
</tbody>
</table>

The **Type** column identifies the type of action, which can be Object, Item, or Page.
To add an object action

*Either:*

- Open the **Insert** menu, choose **Action Item**, then choose the action from the submenu.

*Or:*

- Click the **Action** button in the toolbar, choose the action from the drop-down menu, then drag to draw an item on the page.

Object actions are shown as an object on your page, and you can move or resize the object to determine how it will appear:

![Object action example](image1)

To apply an item action

- Select the item.
- Open the **Item** menu, choose **Actions**, then choose the action from the submenu.

Item actions are applied to a selected item on the page. Most item actions can be applied to a graphic item. Some item actions can also be applied to other items, such as HTML items or table items.

When an action is applied to an item, the name of the action is displayed in the top left corner of the item:

![Item action example](image2)

To apply a page action

*• Display the appropriate page.*

*• Open the **Page** menu, choose **Actions**, then choose the action from the submenu.*

Page actions affect the current page in your site.

![Page action example](image3)

The name of the action will be displayed in the top left corner of the page:

To apply multiple actions

You can apply multiple actions to a single item or page. The actions will be listed in the top left corner of the item:

![Multiple actions example](image4)

The **Actions** palette shows a tab for each action, and you can click the corresponding tab to display or edit the parameters for that action:
To remove an action

- Click the x button to the left of the action’s tab in the Actions palette.

Dynamic buttons and text

Dynamic buttons change appearance when the user moves the mouse pointer over them; this is referred to as a rollover. Rollover text is similar, and changes appearance when the user moves the mouse pointer over it.

To create rollover buttons

- Create three versions of your button: A normal version, a version to be displayed when the user moves the mouse pointer over the button, and a version to be displayed when the user clicks the button:

  ![Email Me!](image1)

  ![Email Me!](image2)

  ![Email Me!](image3)

- For convenience give the items appropriate names, such as Normal, MouseOver, and Click on the item general settings panel of the Inspector palette:

- Select all three items.
- Open the Item menu and choose Align...
- Click the Horizontal center align and Vertical center align icons, and click the OK button:

  ![Alignment](image4)

  The items will be aligned into a stack with them still selected:

  ![Stacked Items](image5)

- Open the Item menu, choose Group.
- Open the Item menu, choose Actions, then choose Rollover from the submenu.
- Open the Window menu and choose Actions to display the Actions palette.

  ![Actions Palette](image6)

This allows you to specify which image should be displayed for each of the conditions: Normal, MouseOver, and Click.

Initially there is a checkmark against each image in the Normal column, so the images are all visible in the normal state.
• Click to remove the checkmark from the Normal column for the MouseOver and Click images, and click to add a checkmark in the appropriate MouseOver and Click columns for these images:

You can click each column heading to preview the graphic corresponding to that state.

You can now preview the effect of your rollover button:

• Click the Preview tab at the bottom right of the Freeway window.

You can also use the Rollover action to trigger slave images; see Slave images and layers, page 93.

To create a text rollover

The Text Rollover action can be used to trigger slave effects when the mouse moves over a text link.

• Position the insertion bar in the HTML item where you want to create the text rollover:

You have specified that the rollover action will send trigger 1 to slave group Indigo. The next step is to define a slave to be triggered.

A typical use of the text rollover is to display a hidden picture when the user moves the mouse pointer over the text.

• Select a graphic item containing a picture.
• Open the Item menu, choose Actions, then choose Slave Image from the submenu.
• In the Actions palette uncheck the image in the Normal column, so the image is not normally displayed, and check the image in the Image 1 column, so that it is displayed by trigger 1:

If you also want the text rollover to act as a hyperlink, you can define it as a link in the usual way by selecting it and then using the Edit Hyperlink dialog box.

• In the Parameters panel ensure that slave group is set to the same slave group as the text rollover, Indigo:

The image will now be displayed when the user moves the mouse pointer over the text rollover:

The Cheetah is an atypical member of the cat family that hunts by speed rather than by stealth or pack tactics.
Slave images and layers

The slave actions are actions you can make happen on your Web page, such as displaying an image, displaying a layer, or opening a pop-up window.

Slave actions are triggered by another action, such as a graphic or text rollover.

**To show one of several slave images**

The Slave Image action allows you to display one of several images depending on the trigger number.

For example, you could provide two rollover graphics each of which displays a different image:

1. Select the graphic item.
2. Open the Item menu, choose Actions, then choose Rollover from the submenu.
3. In the Actions palette click the Parameters button to display the Parameters panel.
4. Choose an item from the Slave Group menu, and set the MouseOver # to 1:

   ![Slave Image Action](image)

   - Select the graphic item containing the image you want to display.
   - Open the Item menu and choose Slave Image from the Actions submenu.
   - In the Actions palette set the Slave Group to the same value as for the button, and set Image 1 to Items:

   ![Slave Image Parameters](image)
Creating dynamic effects

You can use this technique to define several buttons that display different images when the user points to them with the mouse pointer:

![Images](Cheetah.png) ![Images](Lynx.png)

**To show or hide a slave image**

The **Slave Show/Hide Image** action allows you to display or hide a single image in response to a trigger.

- Select the graphic item containing the image.
- Open the **Item** menu, choose **Actions**, then choose **Slave Show/Hide Image** from the submenu.
- In the **Actions** palette, set **Initially** to **Hidden** if you want the image to be revealed by the trigger, or **Visible** if you want it to be hidden.
- Set the **Slave Group** to the same slave group as the trigger, and the **Slave #** to the number specified in the trigger action.

**Animation**

The actions in this section allow you to create dynamic, animated effects on your Web pages.

**To set up a timed sequence**

The **Sequence Timer** action lets you trigger up to 20 slave actions in sequence at a specified speed.

- Open the **Page** menu, choose **Actions**, then choose **Sequence Timer** from the submenu.
- In the **Actions** palette set **Loop** to **Yes** to play the sequence repeatedly, or **No** to play the sequence once when the page is opened.
- Choose a group from the **Slave Group** pop-up menu.
- For each of the triggers you want to use set the corresponding trigger item to **Yes**:
  - In the **Speed** box, specify the delay between triggers in thousandths of a second. The default value, 500, gives a delay of half a second between triggers.
  - Set an appropriate slave action on each of the images; for example, **Slave Show/Hide Image**.
  - Preview the page to see the effect of the sequence timer.
To display a random sequence
The Random Sequence action is identical to the Sequence Timer action, except that the triggers are performed in a random sequence.

To trigger several events after a specified delay
The Blast Timer action is similar to the Sequence Timer action, except that it triggers up to 20 slave actions simultaneously after a specified delay. For example, it can be used to cause several graphics to appear on the page simultaneously after a delay of five seconds.

- Open the Page menu and choose Blast Timer from the Actions submenu.
- In the Actions palette specify the delay in the Speed box in thousandths of a second, and set each of the triggers you want to use to Yes:

To animate a layer Freeway 4 Pro Only
The Move Layer action animates an HTML item, graphic item, or table defined as a layer. It can be used to add visual interest to a page, and the moving object can have other actions, such as a rollover, applied to it.

- Select the graphic item.

- Select the general settings icon at the top of the Inspector palette to display the item’s general settings, and select Layer in the Properties section:

- Open the Item menu, choose Actions, then choose Move Layer from the submenu.
- In the Actions palette specify the following parameters to determine how the layer moves:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>The time interval between each movement in thousandths of a second.</td>
</tr>
<tr>
<td>X</td>
<td>The distance the layer moves horizontally, at each step, in pixels. Put a negative number to move left.</td>
</tr>
<tr>
<td>X-Limit</td>
<td>The maximum distance moved horizontally, in pixels.</td>
</tr>
<tr>
<td>Y</td>
<td>The distance the layer moves vertically, at each step, in pixels. Put a negative number to move up.</td>
</tr>
<tr>
<td>Y-Limit</td>
<td>The maximum distance the layer moves vertically, in pixels</td>
</tr>
</tbody>
</table>
Creating dynamic effects

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop</td>
<td>Set to Yes to repeat the movement or No to stop after one movement.</td>
</tr>
</tbody>
</table>

- Open the Item menu and choose Link to New Window from the Actions submenu.
- In the Actions palette specify a name for the window, the page to be displayed in the window, the width and height, whether the toolbar and scrollbars should be displayed, and whether it should be resizable:

Pop-up windows

This section of actions causes a new window to be displayed above the main browser window. Pop-up windows are useful for displaying subsidiary information relating to the main page, such as a larger version of a graphic.

Note: You cannot preview the pop-up window actions using Freeway’s built-in Preview mode. Instead, open the File menu and choose a browser from the Preview in Browser submenu.

To display a new window when the user clicks a graphic

The Link to New Window action opens a page in a pop-up window when the user clicks a graphic item.

- Create a new page containing the content you want to display in the pop-up window.
- Select a graphic item on the original page, or an HTML item with a pass-through graphic imported into it.

When you click the graphic a pop-up window will be displayed showing the content of the window you specified:

You can use the Self Closing Pop-up Window action to make the window close automatically; see To make a pop-up window close automatically, page 99.
To define a text link to a pop-up window

The Text Link to New Window action opens a new window when the mouse is clicked on a link.

- Create a new page containing the content you want to display in the pop-up window.
- Place the insertion point in text in an HTML item on the original page.
- Open the Insert menu and choose Text Link to New Window from the Action Item submenu.
- Click outside the HTML item, then click the text link action to select it.

The parameters of the text link action are displayed in the Actions palette.

- Select the name of the page you want to display in the pop-up from the Page pop-up menu.

The other options allow you to specify whether the window has a toolbar and scrollbars, and whether it is resizable:

Setting Use link to Yes allows you to make the text link action into a hyperlink, to redirect the user to a different page in the main window as well as displaying the pop-up window.

When you click the text link a pop-up window will be displayed:

To display a picture in a pop-up window

The Pic to New Window action is similar to the Link to New Window action except that the pop-up window displays a specified image. This is useful for allowing the visitor to display a larger version of a graphic on the page.

- Select the graphic item containing the original image.
- Open the Item menu and choose Pic to New Window.
- In the Actions palette select the image to be displayed in the pop-up window.
Creating dynamic effects

- Specify the width and height of the window, whether the toolbar and scrollbars should be displayed, and whether it should be resizable.

When you click the graphic the specified image will be displayed in a pop-up window:

To display a pop-up window

The Pop-up Window action automatically displays a pop-up window when the user browses to a page. This can be used to display an advertising message, warning, or provide a navigation tool for use on the site:

- Create a new page containing the content you want to display in the pop-up window.
- Switch to the page which you want to display the pop-up window.
- Open the Page menu and choose Pop-up Window from the Actions submenu.
- In the Actions palette select the page you have defined for the pop-up window, specify the initial position for the pop-up window in the Left and Top fields, and the size of the pop-up window in the Width and Height fields.
- Use the Toolbar, Scrollbars, and Resizable menus to specify whether a toolbar and scrollbars should be displayed, and whether it should be resizable.
In the **Delay** field specify the time delay after which the pop-up window should be displayed, in seconds.

**To make a pop-up window close automatically**

- Select the page containing the content to be displayed in the pop-up window.
- Open the **Page** window and choose **Self Closing Pop-up Window** from the **Actions** submenu.

The action has no parameters but simply causes the pop-up window to be closed when the user navigates to a new page in the browser, or closes the browser window.

---

**Navigation**

The actions in this section provide options for navigating between pages in the site.

**To perform a timed redirect**

The **Timed Redirect** action simply redirects the user to a different page after a specified delay. One use is for a splash page, which displays a message to the user and then automatically redirects them to another page after a few seconds.

- Open the **Page** menu and choose **Timed Redirect** from the **Actions** submenu.
- In the **Actions** palette choose the page you want to redirect to from the **Destination** pop-up menu, and specify the delay, in seconds, in the **Delay** box:

**To set up a version redirect**

The **Version Redirect** action automatically redirects the user to another page if their browser is newer than a specified version. For example, this allows you to create a home page that supports old browsers, and redirect users with newer browsers to a more fully featured version of your site.

- Open the **Page** menu, choose **Actions**, then choose **Version Redirect** from the submenu.
Creating dynamic effects

- From the **Destination** menu choose the page you want to redirect the user to, and in the **Netscape Vers** and **IE Vers** text boxes specify the versions of Netscape and Internet Explorer you want to check for:

  - The user will be redirected if they have the specified versions or later of Netscape or Internet Explorer.

**Graphics actions**

The graphics actions can be applied to an image in a graphic item to adjust its color balance, or apply effects such as sharpen, blur, or posterize.

- Each of the graphics actions provide an **Enabled** checkbox:

  - Check **Enabled** to apply the action, and preview its effect on the image.
  - Uncheck **Enabled** to disable the action but leave the parameters set up so you can apply it at a later time.

**To apply image corrections**

The **Photo Magic** graphics action provides a range of image adjustments and corrections

- Select the graphic item you want to apply the action to.
- Open the **Item** menu and choose **Photo Magic** from the **Actions** submenu.

The **Actions** palette provides a series of controls to allow you to adjust all of the characteristics of the image:

  - Use the sliders as appropriate to adjust the characteristics of the image.

The **Reset** button resets the parameters to their defaults.
A
actions 86
  adding 89
  animation 87
deleting 90
dynamic buttons 87, 90
dynamic text 87, 90
item action, applying 89
layers 87, 93
multiple actions, applying 89
navigation 88, 99
page action, applying 89
pop-up window 86, 96
rollover 87, 90
slave images 87, 93
text rollover 91
Actions (Item menu) 89
Actions (Page menu) 89
Actions (Window menu) 91
Actions palette 90
Action Item (Insert menu) 89, 97
Add Style dialog box 47
Alt text 65
Anchor... (Edit menu) 29
anchors 29
  creating 29
  linking to 30
animation 86, 94
  layers 95
random sequence 95
timed sequence 94
trigger after delay 95
attributes in styles 46
background images 23
backup file, restoring 3
border effect, graphic item 63
browsers
  adding 6
default, specifying 7
finding 7
removing 7
button, form item 79
C
character attributes 46
character styles 48
checkbox, form item 80
colors
  adding to color list 19
  creating 20
deleting 20
editing 20
importing 20
web-safe 18
Color dialog box 19
combining graphics 63
conventions ii
crack effect
  graphic item 61
text 43
CSS attributes 46
D
Define Anchor dialog box 30
drop shadow effect
  graphic item 61
text 44
dynamic buttons and text 86
E
Edit Choice dialog box 81
Edit Style dialog box 50
EPS graphics 54
F
file names 3
  alphanumeric 3
  DOS 3
  UNIX/Windows 3
Find/Replace (Edit menu) 41
Fit Page in Window (Zoom menu) 12
Flash animations 66
forms
  actions 83
  creating 78
  hidden fields 83
  setting up 83
  using 78
form items
  button 79
  checkbox 80
  menu/list 80
  radio button 80
text area 82
text field 82
FTP, uploading files 7
G
GIF 54
global illumination angle 44, 61

glow effect
graphic item 62
text 44

graphics 54
Alt text 65
blur (Action) 88
border 63
brightness (Action) 88
color (Action) 88
combining 63
contrast correction (Action) 86
creating 55
deleting 57
displaying 67
drag and drop 56
edit 67
effects 60
export options 64
formats supported 54
GIF 54
glow 62
hyperlink 28
Illustrator 54
JPEG 54
missing 67
Photoshop 54
PICT 54
PNG 54
pop-up window 97
publish problems 68
QDGX 54
resizing 67
replacing 59
shadow 61

graphics (continued)
sharpen (Action) 88
show 67
submit button 79
TIFF 54
transforming 58
updating 67
PDF 54
graphics actions 100
graphic attributes 46
graphic items
copying 38
creating 37, 55
moving 38
oval 55
path outline 55
resizing 38
transforming 38

graphic text 36
converting HTML text 40
effects 43
preferences 39

grids
displaying 14
preferences 16
snap to 14

G: (Page menu) 14, 15

Grids dialog box 14
guides
adding 13
locking 14
preferences 16
removing 14
snap-to distance 16
snap to 14

Guides (View menu) 13

H
Hide Rulers (View menu) 13
HTML format, default setting 2
HTML items
copying 38
creating 37
graphic text, creating 40
moving 38
resizing 38

HTML text 36, 39
HTML 3.2 options 39
HTML 4.01 options 39

Hyperlink… (Edit menu) 29
hyperlinks 28
anchors 29
external sites 31
following 30
graphics 28
managing 32
opening a pop-up window 97
preferences 32
specifying target 30
text 29

I
Illustrator graphics, importing 54
image maps 33
creating 33
tools 34

Import Text… (File menu) 38

J
JPEG 54
JPEG graphics 54
Index

L
layers 93
  animating 94
links, See hyperlinks
link map 32
Lock Guides (View menu) 14

M
.Mac
  uploading files 8
Map Area tools 34
margins
  defining 15
master pages 22, 23
  applying 25
  creating 24
  creating from an existing page 25
  deleting 27
  reapplying items 25
  renaming 27
menu/list form item 80
Modify... (Item menu) 58
multimedia 65
  Flash animations 66
  importing 65
  QuickTime movies 65

N
navigation actions 86, 99
  timed redirect 99
  version redirect 99
New... (File menu) 2
New Document dialog box 2
New Folder dialog box 27

O
Other... (Zoom menu) 12
Oval graphic item tool 55
Oval Map Area tool 34
overlay effect, text 45

P
pages
  background color 22
  background image 23
  converting to master page 25
  creating 22
  default size 2
  deleting 27
  linking 28
  master pages 22
  pasteboard 22
  preferences 22
  rearranging 28
  renaming 27
paragraph attributes 47
paragraph styles 49
pasteboard 22
Path graphic item tool 55
Path Map Area tool 34
personal Web sharing 8
PNG graphics 54
pop-up windows 86, 96
  displaying 98
  graphics 97
  link 97
  self closing 99
Preview in Browser (File menu) 6
publish problems 67
QuickTime movies 66
radio button form item 80
Replace dialog box 41
resampling graphics 67
resources, managing 67
Resources... (Edit menu) 67
Resources dialog box 67
rollover actions 86
rollover buttons, creating 90
rulers
  resetting the origin 13
  showing or hiding 13

S
Save dialog box (File menu) 3
Shockwave animations 66
Show Rulers (View menu) 13
sites
  creating 2
  designing 11
  hosting on your computer 8
  linking to 31
  previewing in a Web browser 6
  previewing in Freeway 6
  publishing 6, 8
  saving 3
  structuring 26
  uploading to a Web server 7
Site folder 2
Site panel 27
  deleting items 27
  renaming items 27
  restructuring site 26
slave images 86, 93
  showing or hiding 94
Snap to Guides (View menu) 14
spelling
  checking 42
styles 46
  adding 51
  applying 50
  attributes 46
  character 48
  creating from text 49
  defining 47
  definitions 50
  deleting 51
  managing 50
  paragraph 49
  show all 50
Styles and Colors (Window menu) 17
Styles and Colors palette 17
style sheets 50
  editing 51
  selecting for a page 52
submit button 79

T
Table… (Insert menu) 70
  tables
    cell spacing 75
color 76
  creating 70
tables (continued)
  deleting columns 74
  deleting rows 74
  editing 74
  importing text 71
  inserting columns 74
  inserting rows 74
  inserting text 70
  joining cells 74
  moving 71
  properties 75
  resizing 72
  resizing columns 73
  resizing rows 73
  selecting cells 72
  selecting columns 72
  selecting rows 72
  splitting cells 74
Table (Item menu) 74
  templates
    creating 3
    selecting 2
text
  background 44
  blur effect 45
  color 45
  converting to graphic text 40
  crack effect 43
  drop shadow effect 44
  editing 41
  emboss effect 45
  finding 41
glow effect 45
  graphic text 36
  HTML text 36
  hyperlink 29
  importing 38
  opacity 45
text (continued)
  overlay effect 45
  preferences 39
  replacing 41
  rollover 91
  scatter effect 45
  shape 43
  spell check 42
  wobble effect 43
text area form item 82
text field form item 82
text rollover action 91
Transform dialog box 59
transform tools 58
U
uploading files
  .Mac account 8
  FTP 7
  personal Web sharing 9
W
Web-safe colors 18
  wobble effect
    graphic item 61
  text 43